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ABSTRACT 

Thin concrete pavement is an economical option for low and moderate traffic roads, where the 

thickness of concrete slab varies from 4-inch to 6-inch. In conventional concrete pavement, dowel bars 

are used to increase load transfer efficiency (LTE) and mitigate transverse joint faulting. However, dowel 

bars cannot be accommodated in the thin concrete pavement due to insufficient clear cover. For such 

pavements, structural fibers are a good option for increasing joint performance or load transfer 

efficiency, as well as reducing faulting. However, only limited studies are available in understanding the 

contribution of structural fibers to the benefits of joint performance and the behavior of fibers during 

the transfer of loads across the joint. In this study, finite element analysis of the thin fiber reinforced 

concrete (FRC) pavement was performed. A six-slab model was developed with a granular aggregate 

layer, replicating the actual field conditions. The effect of concrete and base layer structure, material 

properties, traffic and environmental loads, and joint stiffness on the transverse joint performance and 

critical stresses were studied. It was found that around 40% of the wheel load is transferred through the 

pavement foundation and the rest through the aggregate interlocking and fibers’ lateral stiffness. 

Critical stresses for the fatigue cracks along the wheel path were also determined in this study. This 

study concluded the minimum required lateral stiffness of the structural fibers for a desired level of joint 

performance as a function of the pavement structure.  
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CHAPTER 1:  INTRODUCTION AND BACKGROUND 

For low and moderate traffic-volume roads, thin concrete pavement is an economical option in which 

the thickness of the concrete slab varies from 4-inch to 6-inch. Load transfer efficiency (LTE) between 

adjacent concrete slabs is very crucial for concrete pavement performance. Poor LTE results in 

transverse joint faulting. Conventionally, 7- to 14-inch-thick slabs are considered for high-traffic-volume 

concrete roads (Cervantes et al. 2009) in which 1- to 1.5-inch-diameter dowel bars are used as the load 

transfer device. Dowel bars help in reducing the faulting between the slabs. Un-doweled concrete slabs 

are used for roads with moderate and low-volume traffic where the wheel load is mostly transferred by 

aggregate interlocking and reasonably sound base layer supporting the slabs. 

For low traffic volume roads,  the use of conventional thick concrete slab is uneconomical because of the 

cost of materials. Thin concrete pavements are cost-effective for low-volume traffic roads. However, 

dowel bars cannot be used on such pavements due to the lack of concrete cover availability below the 

dowel bars. Additionally, aggregate interlocking will be less due to the limited cross-sectional area 

(excluding the 1 to 1.5-inch saw cut) at the joints. Structural fibers have been found to be helpful as 

reinforcement because they increase load transfer efficiency and minimize faulting. 

Structural fibers are manufactured using different materials, such as polypropylene, carbon, and steel. 

These structural fibers are available with different stiffness, shape, length, and aspect ratio (ratio of 

length and effective cross-sectional area). Polypropylene-based synthetic structural fibers are the most 

popular in concrete pavement compared to other fibers because of their ease in handling, dispersion 

characteristics, and corrosion resistance (Roesler et al., 2008). The length of structural fibers is typically 

1.5 inches or larger. These fibers can also be straight, crimped, twisted, or of embossed geometry along 

their length. 

At present, the commercially available fibers used in thin concrete pavement showed benefit in 

improving LTE, but the quantity and stiffness of fiber used are not optimum for pavement application. 

The overdosage of fibers could make thin concrete pavement uneconomical. Notably, the fibers used in 

the thin concrete pavement were originally developed for industrial concrete flooring. The loading 

conditions of industrial concrete flooring and concrete pavement are significantly different. Unlike the 

industry floors, which mainly receive light vehicular loads, pavement slab performance is influenced by 

several factors, such as seasonal change, daily temperature gradient, traffic loading, and other variables. 

Therefore, the development of pavement-specific fibers is essential.   

To understand the behavior of fibers in concrete pavements with all influencing variables, more data 

and studies are required. Only a limited number of studies are available on the fiber stiffness necessity 

that can provide enough load transfer benefits.  The relationships between fiber properties (e.g., 

stiffness) and transverse joint stiffness and joint performance (LTE) are also not available. The influence 

of different variables like slab thickness, base thickness, stiffness of fibers, type of fibers, and the dosage 
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of fiber on joint performance and critical stress responsible for the fatigue cracks need to be 

investigated.  

In this study,  finite element (FE) analysis was conducted on the concrete slab model with the help of 

ANSYS® software. A six-slab thin FRC pavement model over a granular base layer was developed. The 

slab size was kept as 6 ft x 6 ft. The six-slab model was more appropriate for replicating actual field 

conditions as the movement of the small slabs affect each other in deflection and load transfer 

efficiency and critical stresses. This FE model consider various parameters, including the concrete slab’s 

seasonal effect, temperature gradient, and climate conditions. The objectives of the study are provided 

below. 

1. Developing a six-slab for thin concrete pavement using FEM computer program (Ansys®). 

2. Conceptualizing different forces that affects joint stiffness and fibers at the transverse joints. 

3. Establishing the required stiffness of fibers to achieve the needed joint performance in thin 

concrete pavements and overlays. 

4. Studying the influence of temperature gradients, seasonal temperature change on the joint 

performance of the FRC pavements. 

5. Determining the critical stresses in the thin FRC pavement as a function of slab and base 

thicknesses 
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CHAPTER 2:  LITERATURE REVIEW 

This chapter presents a brief review of the literature on research works conducted on the fibers and 

fiber reinforced concrete used in concrete pavements. Key distresses of the thin concrete pavements 

observed in field sections are discussed. Finite element modelling of concrete pavement is also covered 

in the literature review. The literature review is to demonstrate the available information and 

knowledge gap regarding the use and consideration of structural fibers in concrete pavements.   

2.1 MAJOR DISTRESSES IN THIN CONCRETE PAVEMENTS 

To quantify the forces affecting the structural fiber used in thin concrete pavement for improving joint 

performance, it is necessary to first understand the types of distresses, loading conditions, and seasonal 

changes that concrete pavement experiences over its lifecycle. Distresses that commonly occur in 

concrete pavement or concrete overlay include fatigue cracking, transverse cracking, longitudinal 

cracking, corner cracking, and transverse joint faulting. The reason for these distresses is due to traffic 

load, environmental load, or a combination of both. The most common distresses in thin concrete 

pavements are fatigue cracks and transverse joint faulting. Thin concrete pavement (or overlay) fatigue 

cracking generally occurs in three directions – transverse direction (transverse to traffic flow), 

longitudinal direction (parallel to traffic flow), and diagonally at the corner of the slab (Vandenbossche, 

2003), as shown in Figure 2.1 and Figure 2.2. Fatigue cracking is caused by repeated traffic loading, 

shrinkage (due to season change), and curling (due to daily temperature change) of the concrete slab, or 

a combination of the three. Due to daily temperature changes, positive and negative temperature 

gradients form in the concrete slab, and these temperature gradients accelerate fatigue damage in the 

rigid pavement. When compared to zero temperature gradient, an increase in temperature gradient of 

1°F/inch in the concrete slab multiplies fatigue damage by ten times (Masad et al., 1996; Ahmed et al., 

1998). To mitigate this distress generally a saw cut, or a full depth joint is provided at predefined 

locations (Harrington et al., 2018). MnDOT pavement design manual has recommended the locations for 

transverse and longitudinal joints for different panel slab thickness, shown in Table 2.1. 
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Figure 2.1: Transverse crack (left) and Longitudinal crack (right) (Harrington et al., 2018). 

 

Figure 2.2 : Diagonal cracking (Harrington et al., 2018). 



 

5 

 

Table 2.1: PCC Joint Spacing/Dowel Bars (MnDOT, 2019). 

 

Another significant distress is faulting, which is defined as the elevation difference between an approach 

slab and a leave slab across a transverse joint or crack (Khazanovich et al., 2004); Figure 2.3 shows the 

illustration of joint faulting. The most common reason for faulting is pumping of fines from the base 

layer due to the water accumulation under the slab. Also, poor drainage and low LTE increases the 

chance of faulting (Huang, 2004; Barman, 2014). In order to prevent excessive joint faulting, fiber, dowel 

bar, in addition to achieving the aggregate interlocking. However, dowel bars are not recommended for 

slab thickness less than 7-inches (MnDOT Pavement Design Manual, 2019). Apart from these two major 

distresses, reflective cracking and slab shattering are also found. Reflective cracks occur directly on top 

of the underlying cracks or joints when thin concrete is used as an overlay over the asphalt layer (Sachs 

et al., 2016). Slab shattering only occur in ultrathin concrete pavement, shown in Figure 2.3, (Barman et 

al., 2021). 
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Figure 2.3: Joint Faulting in thin pavement (left) and slab shattering in ultra-thin pavement(right) (Barman et al., 

2021). 

2.2 STRUCTURAL FIBERS  

Dowel bars have proved to be helpful in increasing the LTE in conventional concrete pavement. 

However, the MnDOT Pavement Design Manual 2019 does not advise using dowel bars for slabs having 

a thickness of less than 7-inches due to a lack of cover availability, as shown in Table 2.1. As a result, the 

only method for transferring loads between slabs in thin concrete pavement is aggregate interlocking, 

which is insufficient for good joint performance. When tested, it was found that the effectiveness of the 

joints tested with the 5, 7, and 9-kip repetitive loads was 96, 68, and 39 percent after 0.5 million loading 

cycles respectively and the effectiveness after one million loading cycles were 98, 65, and 9%, 

respectively. Considering all other effects, if only aggregate interlocking is available at the joint, 90% of 

joint performance effectiveness will be decreased with the application of the first 1 million standard 

loads, as shown in Figure 2.4. (Colley et al., 1967). 
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Figure 2.4: Effectiveness of joint with only aggregate interlocking (Colley et al., 1967). 

In order to improve the joint performance of thin and ultra-thin concrete pavement, fibers are 

recommended as an alternative to dowel bars with proper aggregate interlocking (Barman et al, 2018). 

The use of fibers as a reinforced material started in the early 1970s. In 1971, the first fiber-reinforced 

concrete pavement was constructed at a truck weigh station In Ohio (Daniel et al., 2009). Later, other 

fiber-reinforced concrete pavement experiment sections were constructed, including 4- and 6-inch-thick 

overlays in the taxiways of Tampa, FL airport (Davenport et al., 2014), two bridge deck pavement 

overlays in Pennsylvania in 1972, and many more. Two types of structural fibers used in concrete 

pavement, steel structural fiber and synthetic structural fibers, are shown in Figure 2.5. In the early 70s, 

Steel structural fibers were introduced first, then synthetic fibers. However, synthetic fibers have gained 

popularity during the past few decades as they are easier to handle than steel fibers and offer corrosive 

resistance. In recent times, steel and synthetic fibers have been combined and employed in concrete 

pavement projects (Davenport et al., 2014). 



 

8 

 

  

Figure 2.5: Steel structural fiber (left) and synthetic structural fiber (right). 

Numerous laboratory, field, and analytical experiments were conducted that demonstrated the 

structural behavior of various fibers in concrete pavement or overlay over time (Barman, 2014; Barman 

et al., 2018; Roesler et al., 2008; Gaddam, 2016; Jang et al., 2014). A field investigation was carried out 

on three types of concrete overlay: plain concrete overlay, concrete overlay containing 0.28% volume 

fraction fiber, and concrete overlay containing 0.44% volume fraction fiber (Chanvillard et al., 1989). 

Figure 2.6 from the study clearly shows that use of fiber in concrete decreases the cracking in concrete 

pavement and increases the life of pavement. Also, fiber helps FRC pavement hold cracks together and 

distribute wheel load between adjacent slabs. Figure 2.7 shows a study performed on faulting on 

MnROAD, in which different thin concrete pavement cells, of thickness 4-inch to 6-inch, with varying 

fiber dosages were constructed and faulting was measured over time. Over a period of two-year 

(accelerated study, ~2 million ESALs), faulting was found to be reduced by approximately 63% in the cell 

with 11.7 lb/cy fiber dosage when compared to cells with no fiber after 2 years (Barman, 2021).  
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Figure 2.6: Influence of fiber on cracking in FRC Pavement (Chanvillard et al., 1989). 

 

Figure 2.7: Influence of fiber on faulting in FRC pavement (Barman, 2021). 

Previous study showed that adding fibers in concrete does not significantly affect compressive strength, 

free drying shrinkage, coefficient of thermal expansion, and modulus of rupture of the concrete. 

Moreover, over-dosage of fiber in concrete mix reduces the workability of concrete (Akkari, 2011). 

Figure 2.8 shows the results of laboratory test performed for comparison of the compressive strengths 
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of plain concrete, polypropylene fiber reinforced concrete, and steel fiber reinforced concrete. It 

demonstrates that there is negligible difference in the compressive strength of concrete after fiber 

reinforcement. However, structural fibers improve the post crack performance by holding the slabs 

together increase the toughness, fatigue resistance, residual strength, residual strength ratio, and load 

transfer efficiency at the joint (Rodezno et al., 2008; Kim et al., 2017; Roesler et al., 2008).  

 

Figure 2.8: Compressive strength vs age for Steel (a) and polypropylene (b) fiber reinforced concrete with plain 

concrete (Kim et al., 2017). 

Using fibers in concrete pavement increases the construction costs from 2 to 20%, depending on the 

fiber type and fiber dosage. However, the addition of fibers can enhance the concrete's resistance to 

frost and permeability, which eventually demonstrates that doing so is cost-effective for concrete 

pavement (Chen et al., 2018). Very few studies were however conducted to understand the stiffness 

required by fibers for reducing transverse joint faulting, improving LTE and pavement service life. 

2.3 FINITE ELEMENT MODELING (FEM) OF PAVEMENTS 

Finite element analysis is a reliable method to determine the structure’s response with different loading 

conditions. Several studies were conducted using finite element analysis to model the concrete 

pavements and analyze their performance. For modeling any type of structure by finite element 

method, it is a must to know the material properties of the component, such as the thermal co-efficient, 

Poisson’s ratio, modulus of elasticity, etc. It is crucial to select the right element for each component 

and the appropriate mesh size to get reliable results from FEM modeling. After modeling the structure 

properly, it can be used to study the structure’s physical responses, including stress, strain, temperature 

distribution and other significant responses (Salman et al., 2014). Additionally, all components of the 

model should have proper mesh sizes for efficient modeling. With small size mesh, program takes a long 

time to run; if the mesh size is too large, the results will not be precisely accurate (Spyrakos, 1994).  
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The behavior of concrete pavements changes throughout the course of their lifespan due to variations in 

moisture content, precipitation, frost and heave. FEM has been found effective in studying these 

changes in concrete pavement behavior. Figure 2.9 shows the validation of the finite element analysis 

solution by Westergaard’s theoretical equation for conventional concrete pavement.  The comparison of 

theoretical and FE solution validated both interior and edge deflection, and interior and edge stress 

solutions (Tabatabaie et al., 1978; Mahboub et al., 2004). Also, another study validated finite element 

solution by using field surveyed falling weight deflectometer (FWD) data. This model was developed 

using ABAQUS software. The comparison of solutions and field data clearly validate the FEM analysis, as 

shown in Figure 2.10 (Uddin et al., 1995). 

 

Figure 2.9: Finite element solution validation by Westergaard’s equation (Tabatabaie et al., 1978). 
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Figure 2.10: FEM solution validation with FWD data (Uddin et al., 1995). 

Previously, many researchers used FEM tools to examine the linear and nonlinear responses of 

pavement to loads imposed by traffic and environment conditions. Some of the studies have examined a 

range of topics like joint load transfer, back-calculation of modulus, dynamic analysis, and responses to 

nonlinear temperature gradients (Maitra et al., 2009; Maitra et al., 2010; Hansen et al., 1998). Figure 

2.11 shows the mechanism of aggregate interlocking between the loaded and unloaded slab. This 

aggregate interlocking is represented by the linear elastic spring stiffness known as the modulus of 

interlocking joint (Kj) (Brink et al., 2005). The value of modulus of interlocking joint (Kj) is represented by 

(MPa/mm) or (psi/inch) indicating that Kj is the stiffness of each spring per square area. The graph 

shown in Figure 2.12 for 300 mm (11.811 inches) concrete slab shows the relation between LTE and Kj, 

as the Kj increases, the LTE also increases (Maitra et al., 2010). Although, the stiffness required for 

higher LTE by aggregate interlocking is very high.  
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Figure 2.11: Finite element interlocking between joints (Maitra et al., 2010). 

 

Figure 2.12: LTE vs Kj (Maitra et al., 2010). 

Three-dimensional FE analysis on jointed plain concrete pavement shows the effect of stress 

concentration on the transverse joint. This study indicates that poor joint interlocking can lead to higher 

stress concentration in the slab, thus the LTE decreases (Davids et al., 2003). To achieve higher LTE and 

smoother riding quality, the LTE should be maximized and faulting at the joint and transverse crack 

should be minimized. Furthermore, higher modulus of elasticity and pavement structure thickness 

improve load transfer efficiency but not significantly. Figure 2.13 shows an FEM model developed for 

Jointed plain concrete pavement (JPCP) for studying the effect of different parameters on LTE. Findings 

of this study clearly show that the effect of modulus of elasticity of concrete, modulus of elasticity of 

base layer, thickness of concrete slab, wheel load magnitude, and frictional force between base layer 

and concrete slab does not affect the LTE significantly. Moreover, by increasing the magnitude of all 
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these parameters, the structure can only achieve increase in LTE by 2%, which is shown in Figure 2.14 

below (Sadeghi et al., 2018). 

 

Figure 2.13: FEM model of JPCP (Sadeghi et al., 2018). 

 

(a) 

 

(b) 

 

(c) 

 

(d) 
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(e) 

Figure 2.14: LTE % vs Different Parameters (Sadeghi et al., 2018). 

Thermal stresses are caused by the curling of a concrete slab because of the temperature variation. 

Figure 2.15 shows the trend of maximum stress due to effect of temperature or curling on plain jointed 

concrete pavement. Figure 2.15 (a) and (b) shows if the length of slab is longer, then the maximum 

stress will be high for positive temperature gradient, whereas, for negative temperature gradient 

changing length of slab does not affect the maximum stress significantly. Figure 2.15 (c) and (d) show 

that increasing the slab thickness increases the maximum stress with both positive and negative 

temperature gradients. Tensile stresses caused by positive temperature gradients were approximately 

85-90% of those caused by negative temperature gradients at the same values, shown in Figure 2.15 (e) 

and (f). Furthermore, the effect of friction factor on curling stresses was found to be negligible. Figure 

2.15 (g) and (h) shows the effect of concrete slab geometry on thermal expansion stress. It can be clearly 

seen that by increasing the length of slab and uniform temperature change the thermal stress increases. 

However, slab thickness does not affect the maximum tensile stress for the same uniform change in 

temperature. Figure 2.15 (i) shows the influence of a friction factor on maximum tensile stress for 

different uniform temperature changes. According to the data, tensile stresses will increase with an 

increase in the friction factor and a uniform change in temperature. Although, the change in stress is not 

significant, it can slide the slab if the slab is free to move (Masad et al., 1996).  
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(a) 

 

(b) 

 

(c) 

 

(d) 

 

(e) 

 

(f) 
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(g) 

 

(h) 

 

(i) 

Figure 2.15: Stress vs different parameter due to temperature variation (Masad et al., 1996). 

At the University of Pittsburgh, bonded concrete overlay on asphalt was analyzed using finite element 

analysis and laboratory tests, as shown in Figure 2.16 (Barman, 2014). These findings clearly 

demonstrated that the thin overlay of fiber reinforced concrete improved load transfer efficiency and 

increased the stress distribution area. This research found that using fiber reinforced concrete reduces 

debonding stress by 50 to 72 percent compared to plain concrete. Furthermore, at any given crack 

width, load related stresses are found to be decreased by approximately 6%. Using fiber also improves 

the concrete's residual strength and the overlay's post-crack performance. 
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Figure 2.16: FEM Model of FRC overlay over HMA layer (Barman et al., 2014). 

2.4 SUMMARY 

• The use of thin and ultra-thin concrete pavement may be economical for low volume roads. 

Additionally, thin concrete pavement can also be used as overlay over existing pavement.  

• The major distresses that occur in this type of pavement are fatigue crack and joint faulting. The 

reasons for these distresses are environmental loading, traffic loading or a combination of both. 

• Because of lack of cover availability, dowel bar is not recommended in thin concrete pavement. 

However, with proper aggregate interlocking and fiber dosage in thin concrete pavement, better 

joint performance can be achieved. 

• Several studies have been carried out on the performance benefit of fiber in concrete 

pavement. However, there is lack of understanding regarding the stiffness required by the fiber 

for thin concrete pavement. 

• According to earlier research, FEM is a very reliable tool for determining the response of linear 

and non-linear structures under various loading conditions. For concrete pavement, FEM 

incorporates all loading conditions by including traffic loading, curling and shrinkage of concrete 

slabs, and various pavement parameters. 

• The use of a spring element for modeling was found to be very reliable in obtaining the required 

stiffness and gives information about how joints work. 

• Overall, the review of the previous studies show a strong trend towards using fiber in thin 

concrete pavement. Yet, it is unclear what level of stiffness the fiber needs to function at its best 

in a joint. With the help of finite element modeling, this knowledge gap will be filled up 

considering all possible loading condition occurring in actual field. 
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CHAPTER 3:  RESEARCH METHODOLOGY 

In this chapter, the key steps of this research are explained broadly. Figure 3.1 shows a flowchart of the 

key steps of the study. The work started with a review of the literature to understand the different 

aspects of the FEM modeling of FRC pavements. The forces acting on structural fibers used in concrete 

pavements, particularly at the transverse joints, have been conceptualized. All potential interactions 

between the forces are modeled using ANSYS® software. As the model represents actual field 

conditions, all potential loadings and field material characteristics are applied to various combinations of 

pavement structures. In the next step, all the FEM models were  set and run, and data were extracted. 

The results were validated with field data. Based on those values, the required joint stiffness was 

established for improving joint performance. Moreover, fiber stiffness contribution to achieve desired 

overall joint stiffness was established. In the following sections, these step are further explained from 

the method of development of the model to the method followed for achieving better performance of 

the FRC pavement. 

3.1 DEVELOPMENT OF THE FEM MODEL 

A six-slab model was developed in FEM software ANSYS®, as shown in Figure 3.2. In this model, there are 

six main components – FRC slabs, fibers, base layer, loads, boundary conditions, and combined modulus 

of subgrade reaction. Each slab is 6 ft x 6 ft in size; the thickness of the slab and base layer was varied as 

required.  Vehicle load was applied in the form of two uniformly distributed loading areas, located near 

the transverse joint along the outer wheel path. Frictional force due to vehicle passing was applied in 

the opposite direction of the traffic. Furthermore, temperature gradient, base modulus and subbase 

modulus were applied as per season of analysis. Steps followed to develop this model are explained in 

the following sections. 
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Figure 3.1: Research activity flow chart for thesis work. 
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Figure 3.2: Six-slab FEM model of thin concrete pavement. 

3.1.1 Model elements and mesh size 

For modeling concrete slabs and base layer material, SOLID 186 element was used, as shown in Figure 

3.3, (SOLID186, 2017). This element has 20 nodes, allowing elements to translate in all x, y and z 

directions. Each node has three degrees of freedom (x, y, and z). This specific element is capable of 

supporting a variety of material characteristics, including plasticity, hyperelasticity, creep, stress 

stiffening, big deflection, and large strain capacities. Additionally, it may simulate the deformation of 

fully incompressible hyperelastic materials, almost incompressible elastoplastic materials, and mixed 

forms of both. This component also aids in the modeling concrete slab’s tendency to curl due to the 

positive and negative temperature differential.  

 

Figure 3.3: SOLID186 

The element, MATRIX27 (MATRIX27, 2017) was used to model the aggregate interlocking and fibers’ 

contribution at the joint. This element joins two nodes, each of which has three degrees of freedom for 
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rotation (x, y, and z) and three degrees of freedom for translation (x, y, and z). In this model, MATRIX27 

is defined by its stiffness. The functionality of MATRIX27 is further explained in sections 3.1.4 and 3.1.5 .  

Models were created with different mesh sizes in the early stages of modeling, but over time it was 

found that 1-inch x 1-inch x 1-inch mesh size was the most effective for the concrete slabs. In order to 

optimize the mesh size the base layer was split into two sections. The first 3 inches from the top have a 

mesh size of 1-inch x 1-inch x 1-inch, and the rest have 4-inch x 4-inch x 4-inch meshes. The above mesh 

size selection helped to optimize the model run time and helped to connect the bottom of the slab with 

the top of the base by MATRIX27 at the interface. Also, similar mesh sizes were used in concrete overlay 

modeling in previous studies (Barman, 2014; Nishiyama, 2005). 

3.1.2 Boundary conditions  

In actual field, the length of the pavement is very long and contains 100s of slabs. In order to 

accommodate the effect of the nearby slabs, proper boundary conditions were applied to simulate the 

field conditions appropriately with a smaller number of slabs. The slabs are free to move vertically under 

these boundary conditions. The adjacent slabs offer resistance to the slab’s tendency to shrink or 

expand as the season changes; the boundary condition used in the model exhibits such behavior and 

improves the model’s practicality. The slab rotations were unrestricted in all directions, allowing the slab 

to curl in both the upward and downward directions in response to changes in the temperature 

gradient. Elastic support was used at the bottom of the base layer to serve as a combined modulus of 

subgrade reaction. The effect of the seasonal changes was considered in the combined modulus of the 

subgrade reaction and base modulus.   

3.1.3 Forces in thin FRC pavement  

The model considered every potential force that can impact the joint performance of FRC pavement to 

reflect real-world conditions. Figure 3.4 shows all forces that can potentially influence joint 

performance. In the FRC pavement, the most critical force is the vehicle wheel load, which deteriorates 

the joints. A dual-wheel assembly was used in this FEM analysis. Wheel load is only applied to one slab 

due to the small 72-inch × 72-inch panel size. As shown in Figure 3.2, these dual-wheel assembly load is 

applied on the outer wheel path in the form of uniform pressure, 93.75 psi on two 6-inch x 8-inch 

rectangular load areas psi (equivalent to 1 standard axle load of 9,000 lbs). The outer load area is 12 

inches away from the outer edge of the slab. The center-to-center distance between the two load areas 

is 14 inches. Apart from the 93.75 psi standard load, the overloading and underloading of the vehicles 

are also considered, as shown in Table 3.1. 

Several other dynamic and static forces come on concrete pavement that are essential to account for, 

especially for thin and small concrete pavement panels. In concrete pavement, during the daytime, the 

pavement is directly exposed to sunlight. Because of that the temperature at the top will be higher than 

the bottom of the slab, which ultimately causes downward curling. Similarly, the reverse phenomenon 

occurs during nighttime, which causes upward curling, as shown in Figure 3.4. The highest day and 
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lowest night temperature gradients for five different seasons were determined using temperature data 

gathered from the 2017 MnRoad thin cell test, mentioned in Table 3.1, (Barman et al., 2021) in order to 

account for this effect in the FE model.  

Unlike conventional concrete pavement, thin FRC pavement panels are small and thin in size. Because of 

that, the panel moves forward or backward when a driver applies the brake or accelerates the vehicle. 

This happens due to the frictional traction between the tire and pavement interface. To include the 

effect of this frictional traction, a horizontal shear pressure with a coefficient of friction of 0.15, was 

applied to the wheel pressure area in all analyses. Furthermore, the effect of coefficient of friction on 

the joint performance is also studied by varying  this coefficient; the coefficient of friction values are 

shown in Table 3.1. 

 

Figure 3.4: Key forces on the transverse joints of a thin FRC pavement on a granular aggregate layer. 

(a) at downward curling, (b)  at upward curling 

Table 3.1: Forces in thin FRC Pavement. 

Temperature gradient (Day) (oF/in) Early spring: 5.35; late spring: 5.35; summer: 4.71; 

fall: 3.11; winter: 4.48. 
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Temperature gradient (Night) (oF/in) Early spring: -2.15; late spring: -2.42; summer: -

2.92; Fall: -2.19; winter; -2.56. 

Wheel load pressure (psi) 70, 80, 90, 93.75, 100, 110, 120, 130, 140 

Coefficient of frictions 0.15, 0.3, 0.45, 0.6, 0.75, 0.9 

 

3.1.4 Transverse and longitudinal joints  

In FRC slabs, the load transfers from one slab to another through two mediums; aggregate interlock and 

structural fibers, as shown in Figure 3.5. The combined effect of fiber and aggregate interlocking is 

modeled in FEM with the help of MATRIX27 element. This MATRIX27 element connects node to node, 

and each node has six degrees of freedom: three in translation and three in rotation. This element is 

represented by its elastic kinematic response, which is defined by matrix form's stiffness coefficient (k). 

 

Figure 3.5: Schematic of aggregate interlocking and fibers in concrete pavement joints. 

Figure 3.6 shows the mechanism used to model the joints of FRC pavement with the help of FEM. The 

lateral stiffness produced by aggregate interlocking and fibers in the z-direction is represented by the 

vertical joint stiffness coefficient, abbreviated by kz. The stiffness provided by aggregate interlocking and 

fibers in the x and y directions is known as the horizontal joint stiffness coefficient, abbreviated by kx 

and ky. In this analysis, it is assumed that the coefficients kx and ky are the same. MATRIX27 is not 

assigned at top 1-inch in all transverse and longitudinal joints as 1-inch deep saw cut was considered in 

this model, as shown in FEM screenshot. The unit of single node stiffness coefficients is lbf/inch/node; 

we can find the stiffness required by each fiber by multiplying kx or ky with the number of nodes covered 

by each fiber. As 1-inch x 1-inch meshes were used in the concrete slab, and only corners nodes were 

connected at the slab-to-slab interface, the unit of the stiffness coefficient is basically, psi/inch3.  
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Figure 3.6: Slab-to-slab joint modeling for the FRC thin pavements. 

3.1.5 FRC slab and base layer interface 

In unbonded concrete pavement, the concrete slabs are not bonded with the base layer. In that case, 

the friction force offers resistance against the horizontal movement of the slabs. In the FEM model, 

MATRIX27 was used at the interface to provide resistance to the slabs against free sliding in place of 

applying a friction interface between the FRC slab and base layer, providing the same effect the 

frictional force would exert. This helped with optimizing the model run time, cut by many hours when 

the MATRIX 27 was used at the interface. Separately, an analysis has also been performed to investigate 

the interface bonding on the critical stresses. 
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3.2 PAVEMENT STRUCTURE AND MATERIAL 

After developing the generic FEM model for thin FRC pavement, several pavement structure 

combinations were modeled to examine all potential load scenarios on FRC pavement, particularly the 

worst scenarios. Three slab thicknesses—4, 5, and 6 inches—as well as four base layer thicknesses—4, 6, 

8, and 11 inches—were taken into consideration. Both longitudinal and transverse joints have a 1-inch-

deep saw cut. 

Different pavement structures and properties of the materials used in this study for the FEM model are 

shown in Table 3.2. Previous research works have shown that adding synthetic fiber to concrete does 

not considerably increase the compressive strength and modulus elasticity of concrete (Barman et al., 

2018). Therefore, concrete’s Poisson’s ratio and modulus of elasticity were assumed constant values for 

all cases. The modulus of elasticity of 4,300,000 psi and 0.2 Poisson’s ratio were considered. The thermal 

conductivity of the concrete was assumed as 0.31223 BTU/sec-inch-oF. Base and sub-grade layer 

materials are susceptible to seasonal variations because of moisture content’s significant effect on the 

modulus. Five seasons were considered based on the climate of Minnesota. The data collected from the 

MnROAD (Barman, 2021) showed that the base modulus and the modulus of sub-grade reaction are the 

lowest in the spring season due to the thawing action of ice and highest in the winter season because of 

freezing action. As shown in Table 3.2, the base modulus varies from 9,000 psi to 50,000 psi from spring 

to winter, respectively, and the combined modulus of sub-grade reaction from 138 psi/in to 768 psi/in 

from spring to winter season, respectively. The combined modulus of sub-grade reaction was applied as 

elastic foundation beneath the base layer.  

Table 3.2: Summery of pavement design, material, and other variable used in this study. 

Slab thickness (inches) 4, 5, and 6 

Base layer thicknesses (inches) 4, 6, 8, and 11 

Slab modulus of elasticity (psi) 4.3 x 106 

Base layer modulus of elasticity (psi) Early spring: 9,000; late spring: 18,000; summer: 

30,000; fall: 33,000; winter; 50,000. 

Modulus of subgrade reaction (psi/in) Early spring: 138; late spring: 277; summer: 461; 

fall: 507; winter: 768. 

Poisson’s ratio 0.2 
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Thermal conductivity 0.31223 BTU/sec-inch-oF 

3.3 PAVEMENT PERFORMANCE PARAMETERS 

An ideal pavement can be defined as the pavement which provides smooth and comfortable ride to user 

without any distress on it. For characterizing the desired performance for the thin FRC pavement, this 

study focused on two dominating issues: (i) the joint performance parameters which are related to the 

transverse joint faulting, and (ii) the critical stress, which is related to the fatigue cracking.  

3.3.1 Joint Performance Parameters  

Joint performance parameters include three important parameters, load transfer efficiency (LTE), 

differential displacement (DD), and maximum displacement (Dmax). The load transfer efficiency is 

defined by the ratio of displacement of the unloaded slab to the displacement of the loaded slab, 

expressed in percentage (%), shown in Equation 1. Higher LTE indicates better performance of the joint.  

𝐿𝑇𝐸 % =
𝐷2

𝐷1
× 100 (1) 

Where, D2 is displacement of unloaded slab (Slab A) and D1 is displacement of loaded slab (Slab B) near 

the joint; the locations of the D1 and D2 are shown in Figure 3.7. The displacement of the loaded and 

unloaded slab is computed at a location one inch away from the transverse joint along the wheel path in 

lateral direction. As the concrete slabs and base layer participate in transferring wheel load, LTE is 

shared by aggregate interlocking, fiber, and the base layer. In the FEM analysis, LTE by base is the LTE 

when there is no joint stiffness or no interaction between the concrete slabs. LTE by aggregate 

interlocking is the LTE provided by aggregate interlocking mechanism and LTE by the fiber is the LTE 

provided by the fiber’s dowel action. LTE by aggregate interlocking can be defined in the field by the 

difference between the LTE of plain concrete pavement and LTE by the base. LTE by fiber is the 

difference in LTE achieved by pain and FRC concrete pavements. 

The second joint performance parameter differential displacement (DD), DD is the absolute difference 

between the loaded slab displacement and unloaded slab displacement, as shown in Equation 2. 

Contrary to LTE, the higher DD indicates weaker joint performance.  

𝐷𝐷 = 𝐷1 − 𝐷2     (2) 

The maximum slab displacement (Dmax) is the maximum displacement of the loaded slab. Same as DD, 

higher Dmax shows weaker joint performance. Figure 3.7 shows the coordinates (x, y, and z) of each slab 

corner used for modeling the geometry. For each slab, the x and y coordinates are fixed. However, the 

base and FRC thicknesses varied, allowing the z coordinate change in accordance with the analytical 

model. 



 

28 

 

 

Figure 3.7: Location of deflections points. 

3.3.2 Critical Stress in FRC slabs 

Concrete is very strong in compression but weak in tension, thus, the probability of crack initiation is 

maximum where the tension stress is the highest. Stress analysis is performed to understand the 

variation of stress on the FRC pavement due to different loading conditions. This stress analysis also 

helps in locating the critical location for crack initiation. Maximum principal stress (psi) was used in this 

analysis, which is defined as the maximum normal stress that develops on the body where the shear 

stress is zero. Also, the interface between the FRC slab and base affects the stress in the slab. So, both 

bonded and unbonded pavement structures were considered in the FEM analysis. As the wheel path of 

the thin FRC pavement is vulnerable to the longitudinal fatigue cracking, the critical stresses were 

calculated along the wheel path. Figure 3.8 shows the location of the wheel path along which stress 

analysis was performed at the top and bottom of the FRC slab. 



 

29 

 

 

Figure 3.8: Schematic of the FEM model showing the line in the wheel path where the maximum principal stress 

is calculated. 
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CHAPTER 4:  RESULTS AND ANALYSIS 

All the pavement performance parameters that were described before are assessed in this chapter along 

with their results. Results are presented in two separate sections: joint performance parameters and 

critical stresses.  

As discussed in the previous chapter, the FEM model considered the field conditions of the MnROAD; 

however, it is recognized that an exact simulation of the field condition in the FEM model is not possible. 

Some FWD test results were compared with the FEM results in Figure 4.1. Maximum deflection data 

from FWD testing on Cell 606, which has a 5 lb/cy dosage of fiber, were compared with the maximum 

deflection data of an identical FEM-modeled pavement, that has 6-inch slabs over an 11-inch base, the 

same as the design of MnROAD’s Cell 606. For each deflection comparison, the LTE computed from the 

FWD test results and FEM results were similar. While the FEM and FWD data do not show a great match, 

the trends show a reasonable correlation, and it appears that FEM deflections were approximately 3 

times more than the FWD deflections. One of the reasons for this mismatch is the difference between 

the loading natures of the FWD test and the FEM model. The dynamic load in the FWD test gets only a 

fraction of a second to induce deflection on the structure that is not realistically fully elastic. Whereas, 

the static load in the FEM model is applied to a structure that is composed of materials that are assumed 

to be perfectly elastic. Nevertheless, the FEM model developed in this study is certainly capable of 

achieving the goal of the study.   

 

Figure 4.1: Data validation from FWD. 
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The FEM analysis first focused on determining the critical season. A considerably weak design was 

selected for this purpose, 4-inch FRC slabs on a 4-inch base, so that the effect of the seasonal change is 

prominent. Table 3.1 and Table 3.2 listed the seasonal variations in temperature gradient, modulus of 

subgrade reaction, and combined modulus of subgrade reaction, etc. Figure 4.2 shows the variation of 

the joint performance parameters of the abovementioned design for the five different seasons 

considered in Minnesota. As anticipated, the maximum displacement and differential displacement are 

highest in the early spring due to freeze-thawing action. Ironically, the LTE is found to be the highest in 

early spring and least in the winter, but for a genuine reason. The strong modulus of subgrade reaction 

due to frost action in the winter season resists the displacement of the unloaded slab more than the 

loaded slab, which causes the lowest LTE in the winter season. The opposite occurs in the early spring. 

However, the maximum displacement and differential displacement correctly show that early spring is 

the worst season. 

Additionally, the maximum principal stress for each season was determined for the same 4-inch slab on 

a 4-inch base, as shown in Figure 4.3. It can be seen that the maximum principal stress occurs during the 

early spring. Hence, the early spring is considered the critical season for further analysis. The following 

sections include results and observations of both pavement performance parameters. 

 

Figure 4.2: Effect of season on the joint performance parameters (LTE, DD, and Dmax) on 4-inch slab over 4-inch 

base. 
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Figure 4.3: Effect of season on principal stress (Pmax) on 4-inch slab over 4-inch base. 

4.1 JOINT PERFORMANCE PARAMETERS 

In this section, joint performance parameters are analyzed with respect to different factors such as joint 

stiffness, pavement structure, loading etc. This section also examines how varying joint stiffness affects 

the joint performance characteristics under various scenarios. 

4.1.1 Effect of joint stiffness on joint performance parameters 

In this analysis, joint stiffness is categorized into two directions: horizontal stiffness (kx and ky) and 

vertical stiffness (kz). kx and ky represent stiffness in the direction of traffic and its transverse direction 

respectively, while kz indicates the stiffness in the vertical direction.   

To analyze the behavior of joint stiffness in the horizontal direction, the vertical direction stiffness (kz) is 

kept to a minimum of 50 lbf/inch3. The analysis, as depicted in Figure 4.4, reveals that the horizontal 

direction stiffness (kx and ky) doesn't significantly affect joint performance parameters such as LTE, DD, 

and Dmax, even when the stiffness is increased from 0 to 2,500 lbf/inch3. The resulting values of LTE, DD, 

and Dmax are approximately 48%, 0.03-inch, and 0.06-inch respectively (Figure 4.4), and are function of 

the base support, not the joint stiffness. 
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Figure 4.4: Effect of horizontal stiffness (kx and ky) on the joint performance parameters (LTE, DD, and Dmax) on 4-

inch slab over 4-inch base. 

However, as shown in Figure 4.5, differential displacement (DD) and maximal displacement (Dmax) at the 

faulted joint decrease, from 0.003 to 0.004-inch and 0.06 to 0.05-inch respectively, when vertical or 

lateral joint stiffness (kz) increases from 0 to 2,500 lbf/inch3 stiffness. For this analysis, kx and ky were 

kept minimum. Additionally, when joint stiffness kz is increased to 2,500 lbf/inch3, the load transfer 

efficiency rises from 40% to 90%. As a result, all assessments of joint performance were made based on 

vertical stiffness (kz) while maintaining a consistent horizontal stiffness (kx and ky). 

 

Figure 4.5: Effect of vertical stiffness (kz) on the joint performance parameters (LTE, DD, and Dmax) on 4-inch slab 

over 4-inch base. 
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4.1.2 Effect of pavement structure on joint performance  parameters 

In order to quantify the influence of pavement slab and base layer thicknesses, the joint performance 

parameters were computed for several hypothetical pavement structures by varying the slab and base 

layer thicknesses. kz, kx and ky were kept constant as 50 lbf/inch3, while the other variables were the 

same as in the previous analysis. Figure 4.6 shows the effect of the slab and base layer thicknesses on 

the joint performance. It was observed that the increase in the slab thickness from 4 to 6 inches on an 8-

inch-thick base layer did not improve the LTE; although the magnitudes of DD and Dmax decreased by 

0.02-inch and 0.01-inch respectively, with the Increased slab thickness. Figure 4.6 also shows the effect 

of the base layer on the joint performance. It can be seen that the increased base layer to 11 inches 

thickness improved the LTE by 10%, for the pavement with 4 inches thick slab. The Dmax did not change 

with the increase in base thickness and the DD decreased a little with the increase in base layer 

thickness.  

 

Figure 4.6: Effect of the thicknesses of the slab and base layer on the joint performance parameters (LTE, DD, 

and Dmax). 

4.1.3 Effect of daily Temperature cycle on joint performance parameters  

The changes in the pavement slab temperature, temperature gradient, and moisture contents of the 

base and subgrade layers can affect the joint performance, especially in a place like Minnesota where 

significant variation in pavement temperatures and moisture are observed. The pavement temperature 

usually fluctuates between -15 oF in the winter and 120 oF in summer. Figure 4.7 shows the influence of 

the temperature gradient on the LTE. For this analysis, the LTE values were computed for a 4-inch thick 

pavement on a 6-inch granular layer at four different temperature conditions as follows: (i) no 

temperature load was considered, (ii) same temperature at the top and bottom of the slab (95 oF), (iii) 

upward curling at night (temperature gradient = - 2.15 oF/in), (iv) downward curling at day (temperature 
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gradient = 5.35 oF/in). The analysis was performed for the early spring season. Kz values were varied 

while the Kx and Ky were kept constant as 1,500 lbf/inch3. From Figure 4.7, it is observed that the 

influence of the temperature gradient is only noticeable at the lower joint stiffness values.  

 

Figure 4.7: Effect of temperature gradient on LTE (early spring) on 4-inch slab over 6-inch base. 

4.1.4 Effect of wheel load magnitude on joint performance parameters  

The load magnitude for the analysis discussed above was 9,000 lbs, based on the standard axle load of 

18,000 lbs. In actual field situations, the wheel load on the pavement could be more or lower than the 

recommended 9,000 lbs or 93.75 psi pressure. This investigation is performed to better understand the 

effect of wheel loading on joint performance parameters. Wheel load was ranged from 6,720 lbs to 

13,440 lbs, or 70 to 140 psi. As observed in Figure 4.8 , there is only a 5% chance of LTE when wheel 

pressure is increased from 70 to 140 psi, but there is a significant increase in the maximum deflection on 

loaded slabs and the differential deflection. The maximum deflection and differential displacement 

increased by 0.045 inches (53.8 %) and 0.02 inches (50%), respectively, because of the change the load  

magnitude of 70 psi or 6,720 lb. 

As previously indicated, FRC slabs are either directly placed over the base or used as an overlay on the 

existing pavements. Because these slabs are thin and small, there is a possibility that they will move due 

to the frictional traction of vehicles generated by the application of break or acceleration, and this 

movement may affect the joint performance parameters. To investigate this, a analysis was conducted 

in which the amount of frictional force increased in the opposite direction of traffic flow from 15% to 

90% of the wheel load. The analysis's findings, which are shown in Figure 4.9, demonstrate that raising 

the frictional loading has little or no effect on the joint performance parameters. 
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Figure 4.8: Effect of wheel loading on joint performance parameters on 4-inch slab over 4-inch base design. 

 

Figure 4.9: Effect of frictional loading on joint performance parameters on 4-inch slab over 4-inch base. 

4.1.5 Contribution by fiber and aggregate interlocking in joint performance parameters  

As it was explained in Section 3.1.4, the joint stiffness is offered by the aggregate interlock and the fibers 

connecting the slabs at the joints. As one of the goals of the study is to determine the needed lateral 

stiffness of fibers for sufficient joint performance, it is important to separate the joint stiffness by the 

aggregate interlock and fibers. The stiffness value (kz, Kx and Ky) in the FEM analysis is the combination 
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aggregate interlock and fibers, FWD test results from the MnROAD test cells (Cell 506 and Cell 806) were 

used.  

To find the contribution in LTE by base, FEM analysis of all pavement structure combinations was carried 

out considering the joint stiffness in the lateral direction as 0 lbf/inch3. As shown in Figure 4.10, even 

thinnest pavement structure can still achieve about 40% LTE with little to no joint stiffness. 

 

Figure 4.10: LTE at kz = 0 for different pavement structures. 

Figure 4.11 shows the FWD measured LTE data of two cells, Cell 506 which contains no fibers, and Cell 

806 contains 11.7 lbs/cy fiber (Barman and Sharma, 2023). The Cell 506 data shows that the aggregate 

interlock and the base together can achieve 60% LTE. Using the minimum LTE from the base of around 

40% from the FEM analysis shown in Figure 4.10, the aggregate interlock can contribute up to 15 to 20% 

LTE at the beginning of the service life. With time, the stiffness provided by the aggregate interlock 

deteriorated due to abrasion of the concrete matrix at the crack phase. For Cell 806, which had provided 

the desired service life without significant transverse joint faulting and acceptable international 

roughness index (IRI) for about 2.5 million ESALs, showed better LTE results at the beginning of the 

service life as well as later on (Barman et al., 2021).  The difference between the LTEs of Cell 506 and 

806 is because of the fibers’ contribution and based on the results provided in Figure 4.11, it can be 

stated that the LTE contribution of the fibers was around 20 to 25%, for a 5-inch thick concrete 

pavement. 
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Figure 4.11: FWD data from MnROAD test cells. 

Aggregate interlock depends on the effective cross-sectional area of the slab, the thicker the cross-

sectional area, the more the stiffness. From the FWD data, it was clear that a minimum of 15% LTE can 

be achieved through aggregate interlocking. From the FEM analysis shown in Figure 4.12, stiffness 

required to achieve 15% LTE from aggregate interlocking for 4-inch slab, 5-inch slab and 6-inch slab is 

145 lbs/in3, 125lbs/in3 and 105 lbs/in3 respectively. This figure was developed between the LTE 

contribution of the concrete slab (after deducting 40% LTE contribution by base) and Kz. 

 

Figure 4.12: LTE vs Stiffness (by aggregate interlocking and fiber without base). 
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Figure 4.13 shows the fiber stiffness contribution in LTE for different structures. This figure can help 

determine the required lateral stiffness for a desired contribution of fibers. If the structure is strong, the 

lateral stiffness required by the fiber will be less. For example, for a 6-inch slab on 6-inch base structure, 

if the desired LTE from fibers is 30%, then the lateral stiffness from the fibers is 1,400 lbs/inch3. 

 

Figure 4.13: Fiber stiffness contribution in LTE (Trendlines). 

A sample calculation is shown in Table 4.1 for the stiffness required from the fibers at the joint to 

achieve 90% LTE. Column C shows the minimum LTE% that can be achieved from the respective 

pavement structure without joint stiffness. A 15% LTE can be provided by aggregate interlock even when 

the minimum slab thickness is considered, as shown in column D. To calculate the LTE needed from 

fibers, add column C and column D together, then subtract column B values. The required LTE from fiber 

for each structure is given in column F. From the trend lines in Figure 4.13, equations are generated for 

each pavement structure shown in column G, which gives the required stiffness from fiber to achieve 

the desired LTE. Finally, column I shows the stiffness values required from fibers to achieve 90% LTE for 

respective structures.  
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Table 4.1: Fiber stiffness required for achieving target LTE%. 

A B C D E F G H I J 

Pavement 

Structure 

Target 

LTE % 

of the 

joint 

LTE % 

from 

base 

(FEM) 

Minimum LTE 

% contribution 

by aggregate 

interlock 

Stiffness 

required by 

aggregate 

interlock to 

achieve 

minimum 

LTE% (psi/in) 

LTE % 

required 

from fiber 

to achieve 

desired LTE 

at the joint 

(x) 

Equation for 

stiffness by fiber 

R² 

value 

Stiffness 

required 

by fiber 

(y) 

Total 

stiffness 

desired at 

the joint for 

required 

total LTE% 

4" Slab, 4" Base 90.00 41 15 145 34 y = 17.304e0.1375x 0.99 1910 2055 

4" Slab, 6" base 90.00 45 15 145 30 y = 24.804e0.1448x 0.99 1854 1998 

4" Slab, 8" base 90.00 48 15 145 27 y = 32.139e0.1509x 0.99 1800 1945 

4" Slab, 11" base 90.00 52 15 145 23 y = 42.554e0.1587x 0.99 1721 1866 

5" Slab, 4" Base 90.00 41 15 125 34 y = 9.5162e0.15x 0.99 1547 1672 

5" Slab, 6" base 90.00 46 15 125 29 y = 14.285e0.1586x 0.99 1467 1592 

5" Slab, 8" base 90.00 49 15 125 26 y = 19.341e0.1664x 0.99 1398 1523 
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A B C D E F G H I J 

Pavement 

Structure 

Target 

LTE % 

of the 

joint 

LTE % 

from 

base 

(FEM) 

Minimum LTE 

% contribution 

by aggregate 

interlock 

Stiffness 

required by 

aggregate 

interlock to 

achieve 

minimum 

LTE% (psi/in) 

LTE % 

required 

from fiber 

to achieve 

desired LTE 

at the joint 

(x) 

Equation for 

stiffness by fiber 

R² 

value 

Stiffness 

required 

by fiber 

(y) 

Total 

stiffness 

desired at 

the joint for 

required 

total LTE% 

5" Slab, 11" base 90.00 53 15 125 22 y = 27.305e0.1769x 0.99 1295 1420 

6" Slab, 4" Base 90.00 41 15 105 34 y = 5.9363e0.1579x 0.99 1322 1427 

6" Slab, 6" base 90.00 46 15 105 29 y = 9.1296e0.1672x 0.99 1236 1341 

6" Slab, 8" base 90.00 49 15 105 26 y = 12.698e0.1756x 0.99 1157 1262 

6" Slab, 11" base 90.00 54 15 105 212 y = 18.624e0.1876x 0.99 1051 1156 
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4.1.6 Deflection profiles of FRC slabs along the wheel path 

In this section, the deflection profile of loaded and unloaded slabs for different loading conditions are 

presented. Figure 4.14 shows the location of wheel path where the deflection data were calculated. 

Both high and low joint stiffnesses were considered in this analysis. The joint stiffnesses for the low and 

high interface bonding were 50 lbs/inch3 and 2,500 lbs/inch3, respectively. The purpose of this analysis 

was to understand how FRC slab’s physical behavior differs under different loading conditions. For this 

analysis, a 5-inch slab over an 8-inch base is modeled, which is a  design based on the recommendations 

provided in Barman et al. (2021) study. The analysis is performed for the early spring season. 

 

Figure 4.14: Location of deflection analysis along the wheel path. 

4.1.6.1 Slab deflection profile under wheel load 

Figure 4.15 shows the deflection profiles of the loaded (Slab B) and unloaded (Slab A) slabs. For this 

case, only a wheel load of 9,000 lbs was applied in the form of a normal pressure of 93.75 psi on two 6-

inch by 8-inch rectangular areas. When the joint stiffness was low, the deflection in loaded slab B was 

greater than in loaded slab A, as indicated in Figure 4.15 curve. The maximum deflection of the loaded 

slab is 0.046 inch, while that of the unloaded slab is 0.0177 inch. When the joint was stiff, the maximum 

deflection of both slabs was roughly 0.032 inch. Figure 4.16 shows the contour of six slabs in the FEM 

model. The contour of low stiff joint shows deflection is present only on the loaded slab and when the 
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joint is stiff, deflections were observed on the unloaded slabs too, reflecting the benefit of load 

distribution. 

 

Figure 4.15: Deflection profile for only wheel load on 5-inch slab over 8-inch base. 
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Figure 4.16: Deflection contour of low stiff joint (left) and high stiff joint (right) for only wheel load. 

4.1.6.2 Slab deflection profile under frictional load 

In this analysis, 15% of the wheel load was considered as frictional load, applied in the form of a shear 

pressure of 14.1 psi. Figure 4.17show the deflection profiles of loaded and unloaded slabs. From the 

analysis it was found that for thin FRC slab the effect of frictional load is negligible with low stiff joints 

while with high stiff joint this displacement is nil. Contours of slabs with only frictional loading is shown 

in Figure 4.18. Despite the contour's showing color variation, the deflection values are very small and 

near to each other. 
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Figure 4.17: Deflection profile for only Frictional load on 5-inch slab over 8-inch base. 

  

Figure 4.18: Deflection contour of FRC slab with low stiff joint (left) and high stiff joint (right) for only frictional 

load . 
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4.1.6.3 Slab deflection profile under only positive temperature gradient (Day time) 

Concrete slabs curl downward or upward because of the temperature gradients. The temperature of the 

slab is higher at the top during the day than it is at the bottom, creating a positive temperature gradient 

that causes the slab to curl downward, as shown in Figure 4.19. The greatest daytime temperature 

gradient in early spring, 5.34 oF/in, is taken into consideration for this analysis for a 5-inche over 8-inche 

base. The slab deflection caused by a positive temperature gradient is less than the effect of wheel 

loading. Additionally, there was only a slight difference in deflection among joints with low and high 

stiffness, indicating a relatively less influence of joint stiffness on the curling or vice-versa. The deflection 

contour of the slab under positive temperature gradient with low and high stiff joints is shown in Figure 

4.20. Each slab in both deflection contours curves downward, with the most significant displacement 

appeared at the mid of the slab. 

 

Figure 4.19: Deflection profile for only positive temperature gradient on 5-inch slab over 8-inch base. 
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Figure 4.20: Deflection contour of FRC slab with low stiff joint (left) and high stiff joint (right) for only positive 

temperature gradient. 

4.1.6.4 Slab deflection profile under only negative temperature gradient (Night time) 

The negative temperature gradient forms at night when the temperature at the bottom of the concrete 

slab is warmer than the temperature at the top, causing the slab to curl upward as seen in Figure 4.21. 

In this case, the maximum temperature gradient of -2.15 during the night was taken into consideration, 

based on the early spring trend. The difference in deflection between low stiff and high stiff joints was 

quite small, as seen by the deflection profile of the loaded and unloaded slab. The deflection contour of 

six slabs caused by the nighttime temperature gradient is shown in Figure 4.22. The highest 

displacement in the night temperature gradient was found at the center of the slab. 
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Figure 4.21: Deflection profile for only negative temperature gradient on 5-inch slab over 8-inch base. 

  

Figure 4.22: Deflection contour of FRC slab with low stiff joint (left) and high stiff joint (right) for only negative 

temperature gradient. 
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4.1.6.5 Effect of wheel load, frictional load, and positive temperature gradient together 

Early spring daytime temperature gradient, a wheel load of 9,000 lbs and frictional loading of 15% of the 

wheel load are applied for this analysis. The deflection profiles of the loaded and unloaded slabs are 

shown in Figure 4.23. Since the effect of the positive temperature gradient and frictional loading are 

significantly less than the wheel load, the deflection profile is similar to the deflection profile that was 

observed only for the wheel load. Additionally, compared to a high stiff joint, the low stiff joint 

displacement is greater in a loaded slab. The deflection contour of the slabs are shown in Figure 4.24. It 

can be seen that the slabs other than A and B also showed some movement as a result of a positive 

temperature gradient. 

 

Figure 4.23: Deflection profile for combined day time loading on 5-inch slab over 8-inch base. 
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Figure 4.24: Deflection contour of FRC slab with low stiff joint (left) and high stiff joint (right) for combined day 

time loading. 

4.1.6.6 Effect of wheel load, frictional load and negative temperature gradient together 

Wheel load, friction load was combined with the negative temperature gradient loads in this case for 

early spring season. This analysis showed similar results as the wheel load scenario, but the slab's curve 

alters because of the negative temperature gradient, as shown in Figure 4.25. For low stiff joints or high 

stiff joints, the deflection of the loaded slab is greater than that of the unloaded slab due to the stronger 

bonding between the loaded and unloaded slabs. Figure 4.26 shows the deflection contours of the slab. 

The stiffer joint stiffness appeared to distribute the load over wider area as indicated by the deflection 

contours of the adjacent slabs. 
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Figure 4.25: Deflection profile for combined night time loading on 5-inch slab over 8-inch base. 

  

Figure 4.26: Deflection contour of FRC slab with low stiff joint (left) and high stiff joint (right) for combined night 

time loading. 
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4.1.6.7 Comparison of deflections profiles for all the cases 

The deflection profiles under different loading conditions for both low and high stiff joints are compared 

in  Figure 4.27. It is clear that the frictional load does not have much effect on the deflection of a thin 

concrete slab. Concrete slabs curl in either a downward or upward direction depending on nature of the 

temperature gradient. The maximum deflection caused by the temperature gradient in slabs is 0.01 

inches, both for positive and negative temperature gradients. When the slab curls upward, the highest 

displacement occurs at the slab's center, and when it curls downward, it occurs at the slab's edge. 

Wheel load displacement, which is approximately 0.045 inches, was found to be highest when compared 

to all other individual loading. The maximum displacement was observable in day temperature gradient 

t situation when combined loading was applied. The reason for this is the greater deflection at the edge 

in the downward curling. When the wheel load was applied at the edge, the wheel-load induced 

deflection and temperature load induced deflection merges. Because of curling in the opposite 

direction, as seen in Figure 4.27, the maximum deflection at night is a little less than it is during the day.  

 

Figure 4.27: Deflection profile for low stiff joint for different loading on 5-inch slab over 8-inch base. 

Similarly, Figure 4.28 shows comparison of all individual deflection curve with different loading but with 

high stiff joint. In this study too the deflection due to frictional loading was almost zero. Deflection 

profile due to positive and negative temperature profile is same as low stiffness joint curve as it does 

not affect by joint stiffness.  
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Due to the high joint stiffness, the load transfer between Slab B and Slab A is higher which results in a 

lower displacement in the Slab B and increase in the displacement of the slab A as it tries to pull the slab 

downward which smoothen the transition of profile between two slabs. In the case of combined 

loading, the highest displacement occurs during the daytime compared to the nighttime condition. 

Daytime combined loading has a more curved shape since it exhibited the same downward curve shape, 

however, nighttime combined loading has an almost straight shape because it resists the upward 

bending wheel load profile which is also the reason behind higher deflection in day time combined 

loading. 

 

Figure 4.28: Deflection profile for high stiff joint for different loading on 5-inch slab over 8-inch base. 
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carried out on a 4-inch slab over a 4-base in the early spring season to obtain the significant stress trend 

for the FRC joint. The principal stress was not much affected by horizontal stiffness, as shown in Figure 

4.29, but reduced by increasing vertical stiffness.  

 

Figure 4.29: Effect of joint stiffness on principal stress on 4-inch slab over 4-inch base. 

4.2.2 Effect of pavement structure on principal stress  

In this case, various designs of the FRC pavement were examined in order to understand the effect of 

the slab thickness and base thickness on principal stress. The combination of three FRC slab 

thicknesses—4, 5, and 6 inches—and four base thicknesses—6, 8, and 11 inches—was examined. In 

order to achieve critical condition, all models are run with the least amount of joint stiffness for the 

early spring season. The impact of various pavement structures on principal stresses is shown in Figure 

4.30. The graph clearly demonstrates that increasing the FRC slab's thickness by one inch significantly 

decreases principal stress. However, the principal stress reduced slightly with the increment of base 

thickness. So, it is evident that the variation of principal stress depends more on the FRC slab thickness 

than the base thickness. 
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Figure 4.30: Effect of the thicknesses of the slab and base layers on principal stress (psi). 

4.2.3 Effect of wheel loading on principal stress 

As similar to the analysis conducted for the joint performance, the change in the critical stress is also 

studied as a function of the wheel load magnitude. Figure 4.31 shows the critical stresses computed for 

the various wheel load pressures. It may be noted that the design features and materials properties for 

this analysis is identical to the same considered for the analysis performed for the joint performance as 

discussed in Section 4.1.4  Joint stiffness was kept to a minimum, like 50 lbs/inch3. Maximum stresses 

were observed at the bottom of the loaded slab under the wheel load. Also, the relationship between 

the principal stress and the wheel load pressure is found to be linear.  

 

Figure 4.31: Effect of wheel load pressure on principal stress on 4-inch slab over 4-inch base. 
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As previously stated, the behavior of the FRC may slightly change because of the application of a break 

or acceleration. To understand that in this case, frictional pressure was applied in the opposite direction 

of traffic. Although the frictional load was increased from 15% to 90% of the wheel load, the effect on 

the principal stress was not significant, as shown in Figure 4.32. 

 

Figure 4.32: Effect of frictional pressure due to wheel load on principal stress on 4-inch slab over 4-inch base. 

4.2.4 Effect of different loading on principal stress along the wheel path  

Stress analysis was conducted in a way similar to the joint performance section. The stress profiles of 

slab A and slab B were drawn along the wheel path. Unlike the deflection values, slab's stress magnitude 

varies depth wise, thus stress curves were calculated along with the wheel path for both the top and 

bottom of the slab. Additionally, the interface bonding between the FRC slab and the base has impact on 

stress behavior. Therefore, the stress profiles for both bonded and unbonded interfaces were included 

in this study. For bonded interfarance higher kz (500 lbf/inch3) was considerd while for unbonded 

minimul kz was considerd (50lbf/inch3). In both bonded and unbonder kx and ky kept constant (2000 

lbf/inch3). Low and high stiffness joints were evaluated for six different loading scenarios. A pavement 

design with 5-inch slabs over 8-inch bases was used in all the cases. The red dashed line in Figure 4.33 

shows the location of wheel path where principal stress profiles are plotted. Slab B is the loaded slab, 

and slab A is the unloaded slab. 
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Figure 4.33: location of stress profile for stress analysis. 

4.2.4.1 Stress profile under wheel Load 

In this case only wheel load was considered for bonded and unbonded interface. In both bonded and 

unbonded interface model, principal stress was observed at the top and bottom of the slab for both low 

and high stiff joints. Figure 4.34 shows stress curve for low stiff joint. For both bonded and unbonded 

interfaces, the principal stress was found maximum at the bottom of the FRC slab near the transverse 

joint, which was close to 390 psi (tensile). Since the wheel load was applied at Slab B near the joint, a 

compression stress of 94 psi was generated near to the joint at the top of the slab. Also, at the middle of 

the slab, tension stress generates at the top of the slab because of the flexural action of wheel load. At 

the top of slab, the principal stress for the bonded and unbonded interfaces are different as well; it was 

lower in bonded slab compared to unbonded slab because bonded slab distribution more load to the 

base as compared to the unbonded slab. Furthermore, tension stress was observed at the top of Slab A 

when the interference was bonded. This is because of the interface bonding, modeled through 

MATRIX27, which distributes some load to slab A. 

Stress curve location 
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Figure 4.34: Stress profile of only wheel load with low stiff joint on 5-inch slab over 8-inch base. 

Figure 4.35 shows the same loading and bonding condition as Figure 4.34 with only difference is higher 

joint stiffness. The maximum principal stress that occurred in this case was at the same position as with 

low stiff joint, at the bottom near to the joint. However, magnitude of the stress reduced as the load 

distribution area was higher in this case. Also, at the top of the slab, the magnitude of the stress 

decreased as compared to low stiff joint for both bonded and unbonded slabs. 
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Figure 4.35: Stress profile of only wheel load with high stiff joint on 5-inch slab over 8-inch base. 

4.2.4.2 Stress profile under frictional Load 

In this case, only frictional loading was taken into account when drawing the stress profile for loaded 

(slab B) and unloaded (slab A) for both bonded and unbonded interferences. The frictional force was 

taken to be 15% of the wheel load. The influence of frictional force on the principal stress was minimal 

in all cases, as shown in Figure 4.37. Additionally, for both low and high stiff joints, the primary stress 

was remains the same at the top and bottom of the slab. 
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Figure 4.36: Stress profile of only frictional load with low stiff joint (left) and high stiff joint (right) on 5-inch slab 

over 8-inch base. 

4.2.4.3 Stress profile under positive temperature gradient (day time) 

In this case, only positive temperature gradients that result from daily variations in daytime 

temperatures are taken into account. As shown in Figure 4.37, the principal stress profile of slab with 

joints with low and high stiffness are identical, indicating that the stress caused by a temperature 

gradient is independent of the joint stiffness. For both bonded and unbonded slabs, there were different 

stress curves at the top and bottom of the slab. Stress at the top was minimal, but at the bottom, tensile 

stress was greater in the center of the slab due to the concrete’s self-weight trying to achieve its original 

shape. Because bonded interfaces prevent the slab from curling, their principal stress is a little higher 

than in unbonded interfaces. 
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Figure 4.37: Stress profile of only positive gradient with low stiff joint (left) and high stiff joint (right) on 5-inch 

slab over 8-inch base. 

4.2.4.4 Stress profile under negative temperature gradient (night time) 

As shown in Figure 4.38, the profiles for high and low stiff joints are again quite close to one another, 

indicating that joint stiffness has very little effect on it. Similar to daytime curling, the principal stress 

was minimal at the top and slightly higher at the bottom. Because of the compression stress that 

develops in the middle of the slab during the negative temperature gradient, the slab tends to curl up. 

The stress generated in slabs due to thermal loading is quite low because the low self-weight owing 

their small size. Due to model boundary condition, the stress was a bit higher and asymmetrical in the 

corner of slab A. As the slab A tries to curl up at the edge and the bottom slab is resisting the movement, 

stress concentration occurs at the edge due to the boundary condition. 
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Figure 4.38: Stress profile of only negative gradient load with low stiff joint (right) and high stiff joint (left) on 5-

inch slab over 8-inch base. 

4.2.4.5 Effect of wheel load, frictional load and positive temperature gradient togethe r 

In this case, the model has all possible loading and a daytime temperature gradient. Due to the fact that 

frictional load and temperature gradient stress are outweighed by wheel load stress, as shown in Figure 

4.39, the stress curves for bonded and unbonded joints with low and high stiffness resemble only a 

wheel load situation. In this case as well, the most significant stress location was around the joint at the 

bottom of the slab. Wheel load causes compression stress near the junction at the top of the slab. The 

stress in both bonded and unbonded slabs is about equal at the slab's bottom, but it is larger in the 

unbonded slab at the FRC slab's top. This occurs as a result of the slab's increased stress distribution 

during bonding. The identical stress condition is depicted in the left graph with increased joint stiffness. 

The load distribution area will be greater, and the major stress intensity will decrease when the joint 

stiff sufficient. 
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Figure 4.39: Stress profile of combined loading with positive gradient load with low (left) and high (right) stiff 

joint on 5-inch slab over 8-inch base. 

4.2.4.6 Effect of wheel load, frictional load and negative temperature gradient together 

In this case, all loadings are applied in the model with negative temperature gradient which occurs 

during nighttime. Figure 4.40 shows the profiles for low and high stiff joints with bonded and unbonded 

interferences. Both the graph’s shapes are similar to the only wheel load case. In this case, maximum 

tensile stress occurs at the bottom of the slab near the joint. At the top of the slab, maximum tensile 

stress occurs in the middle of the slab. In the right-side graph for the high stiff joint, critical stress 

location is same, but the intensity decreases as the load distribution area is more. Bottom stress profile 

for both low and high stiff joints, the stress magnitude of bonded and unbonded is almost same. 

However, at the top of the slab, the principal stress is little higher when the slabs are unbonded as 

compared to bonded interference, because the slabs in unbonded interface case are freer to move. 
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Figure 4.40: Stress profile of combined loading with negative gradient load with low (left) and high (right) stiff 

joint on 5-inch slab over 8-inch base. 

4.2.4.7 Comparison of stress profile for all the cases (Bonded) 

In this section, all of the previously examined cases were compared for bonded interference. The stress 

profile along the wheel path at the top of the slabs for the low stiff joint and the high stiff joints is shown 

in Figure 4.41. The center of the slab experiences the highest principal stress for low stiff joints at the 

top of the slab. Stress was maximum for the wheel load and was generated at the middle of the slab. 

Stress generated by frictional loading was negligible as compared to other loadings. A positive 

temperature gradient produces slightly more stress than a negative temperature gradient. Therefore, 

the middle of the slab experiences more stress when all combined loading and a temperature gradient 

are applied. When the joint stiffness was high, a similar tendency can be noticed; the main difference is 

that the stresses are lower than for low stiff joints due to the larger load distribution area across the 

joint. The stress was higher in Slab A when the joint was stiff. This is because the edges of Slab A have 

higher constraints at boundary conditions in FEM. 
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Figure 4.41: Comparison of stress profile of different loading condition at top of slab for low stiff joint (left) and 

high stiff joint (right) bonded interface on 5-inch slab over 8-inch base. 

Figure 4.42 shows the stress curve at the bottom of the slab, when the interference of the slab and base 

was bonded. In all the curves the principal stress was the highest during the combine loading case. The 

critical stress is very close to each other when positive or negative temperature gradient is applied. Only 

wheel load stress curve at the bottom of the slab has little less stress than the combined cases. Stress 

curve due to only positive and negative temperature gradient shows some stresses but very less as 

compared to the combine loading stress curve. At bottom of the slab too, frictional loading stress curve 

shows negligible stress. When the joint stiffness was high, the trend was same as the low stiff joint but 

with less stress values. The stress curve in both low and high stiff joint shows an unsymmetrical behavior 

in slab A where the stress is concentrated at the end which is again because of the boundary conditions. 
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Figure 4.42: Comparison of stress profile of different loading condition at bottom of slab for low stiff joint (left) 

and high stiff joint (right) bonded interface on 5-inch slab over 8-inch base. 

4.2.4.8 Comparison of stress profile for all the cases (Unbonded) 

Figure 4.43 and Figure 4.44 shows the comparison study of all loading case with low and high stiff joint 

with unbonded joint interference. In Figure 4.43 shows the stress profile at the top of the slab along the 

wheel path for all loading cases. It can be clearly seen that stress due to wheel load is maximum at the 

middle of the slab and some compression stress where the load is applied. The stress generated by only 

frictional loading, positive and negative temperature gradient is very less compared to the Wheel load. 

But when temperature gradient and frictional loading applied with wheel load stress curve shows a little 

difference. As shown in graph, the combined loading with negative temperature gradient has little less 

effect than only wheel load’s stress profile. 
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Figure 4.43: Comparison of stress profile of different loading condition at top of slab for low stiff joint (right) and 

high stiff joint (left) with unbonded interface on 5-inch slab over 8-inch base. 

With an unbonded interference between the base and the slab, Figure 4.44 shows the stress profiles at 

the bottom of the slab for high and low stiff joints. The critical principal stress for a wheel load and a 

combined loading for a positive and negative temperature gradient are closer to one another. In 

comparison to wheel loading, the impact of individual other loading is quite small. As previously 

mentioned, slab A stress exhibits asymmetrical behavior due to boundary conditions where there is 

stress concentration at edge. In the wheel load scenario, the stress intensity in Slab A is higher when the 

joints are stiffer. Overall, the critical stress is lower when the joint stiffness is high because load is more 

evenly distributed. 
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Figure 4.44: Comparison of stress profile of different loading condition at bottom of slab for low stiff joint (right) 

and high stiff joint (left) with unbonded interface on 5-inch slab over 8-inch base. 

4.3 SUMMARY 

From the different analysis performed it is evident that joint stiffness plays a major role in pavement 

performance. It not only reduces the deflection of the slab but also reduces the stress concentration in 

slab by widening the load distribution area. Table 4.2 and Table 4.3 shows the summary of maximum 

principal stress values and maximum deflection values for low and high stiff joints for bonded and 

unbonded interface, respectively. According to the findings, the possibility of crack initiation is from the 

bottom of the slab during the night time near the loaded slab's transverse joint. 
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Table 4.2: Summary of maximum principal stress and maximum displacement for bonded slab. 

Bonded 

Loading 
type 

Location 
on FRC 

slab 

low stiff joint Hight stiff joint 

Max 
principal 

stress 
(psi) 

Max 
displacement 

(inch) 

Max 
principal 

stress 
(psi) 

Max 
displacement 

(inch) 

Only 
wheel 
load 

Top 158.49 -0.04596 100.64 -0.03253 

Bottom 375.72 -0.04596 319.68 -0.03253 

Only 
friction 

load 

Top 8.2404 0.001235 8.3391 0.000474 

Bottom 14.043 0.001235 12.298 0.000474 

Only +ive 
gradient 

Top 0.30207 -0.01057 0.30003 -0.01056 

Bottom 58.34 -0.01057 58.38 -0.01056 

Only -ive 
gradient 

Top 17.353 -0.00835 20.668 -0.00849 

Bottom 30.79 -0.00835 38.357 -0.00849 

Combined 
loading 

with +ive 
gradient 

Top 101.77 -0.0556 47.197 -0.04239 

Bottom 391.99 -0.0556 337.31 -0.04239 

Combined 
loading 

with -ive 
gradient 

Top 150.18 -0.05103 94.733 -0.03796 

Bottom 393.21 -0.05103 338.98 -0.03796 
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Table 4.3: Summary of maximum principal stress and maximum displacement for unbonded slab. 

Unbonded 

Loading 
type 

Location 
on FRC 

slab 

low stiff joint Hight stiff joint 

Max 
principal 

stress 
(psi) 

Max 
displacement 

(inch) 

Max 
principal 

stress 
(psi) 

Max 
displacement 

(inch) 

Only 
wheel 
load 

Top 230.76 -0.09673 110.37 -0.05047 

Bottom 392.94 -0.09673 322.9 -0.05047 

Only 
friction 

load 

Top 8.2404 0.001235 8.3624 0.000611 

Bottom 14.043 0.001235 12.643 0.000611 

Only +ive 
gradient 

Top 0.31266 -0.01156 0.31082 -0.01149 

Bottom 40.204 -0.01156 40.214 -0.01149 

Only -ive 
gradient 

Top 7.0243 -0.00729 15.212 -0.00792 

Bottom 32.558 -0.00729 30.604 -0.00792 

Combined 
loading 

with +ive 
gradient 

Top 190.32 -0.10634 75.753 -0.06089 

Bottom 397.47 -0.10634 329.12 -0.06089 

Combined 
loading 

with -ive 
gradient 

Top 214.3 -0.1005 99.847 -0.05526 

Bottom 411.42 -0.1005 344.34 -0.05526 
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CHAPTER 5:  CONCLUSIONS AND RECOMMENDATIONS 

Thin fiber-reinforced concrete pavement could be an economical choice for roads with low to moderate 

traffic volumes. FRC pavements can be laid directly over a granular base or as an overlay on an existing 

pavement. According to prior studies, transverse joint faulting is one of the major distresses that 

contribute to early pavement deterioration and affect the user riding quality. The commercially available 

fibers provide benefit to joint load transfer when added in large quantities, making FRC pavement 

uneconomical. Therefore, pavement-specific fibers are required to be developed.  

To determine how much stiffness is necessary for optimal joint performance, a thorough investigation 

has been done in this study. This study focused on the development of the FEM model of six-slab FRC 

pavement over a granular base incorporating all possible forces. Based on the analysis and results 

following conclusions are made. 

• It is found that the lateral stiffness of the fibers is important, and this shall be one of the key 

areas where fibers need improvement. By improving lateral joint stiffness, the slab displacement 

can be reduced by 31% and maximum principal stress can be decreased by 16% and 21% for 

bonded and unbonded pavements or overlays, respectively. Also, the load transfer can be 

improved by 60%.  

• Seasonal analysis shows that the highest maximum displacement and differential displacement 

are observed in early spring (freeze-thaw), making this season critical for joint performance (LTE, 

slab deflection, etc.).  

• Joint performance is also impacted by pavement structure, though not to the same extent as 

joint stiffness. That’s why, the analysis was focused mainly on the effectiveness of joint stiffness 

while characterizing the joint performance. 

• Curling due to daily temperature change causes deflection and stress in the FRC slab, but not 

significantly. Also, this change does not affect joint stiffness much. 

• The frictional traction at the interface of the vehicle tire and slab surface has little to no effect 

on the behavior of the FRC slab in terms of displacement or principal stress. Under and over-

loading of the wheel load directly impacts the pavement performance parameters. Wheel load 

is the most critical load that affects the principal stress and deflection of the FRC slab. The 

standard wheel load alone can produce principal stresses of up to 87% and displacements of up 

to 82% of the all the forces that affects the then FRC pavements .  

• The impact of thermal loading is very low as compared to the wheel load. However, 

combination of thermal loading with wheel loading makes the worst scenario. The critical stress 

during the positive and negative temperature gradient is very close to each other. However, the 

combined loading with negative temperature gradient is proven to be critical for stress, which 

causes nearly 400 psi principal stress. Also, the maximum displacement was observed in 

combined loading with positive temperature gradient with 0.041-inch displacement with low 
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stiff joint. However, this maximum principal stress and maximum displacement can be reduced 

by 15% and 25%, respectively by increasing the joint stiffness. 

In this study, every possible factor influencing pavement joint performance and critical stresses 

were considered. The future study shall focus on establishing a test method to determine the fibers’ 

lateral stiffness so that pavement specific fibers can be designed, developed, and tested.  

Additionally, the lateral stiffness suggested by the FEM model may not be the exact amount that will 

be required for the field application. Research shall be conducted to correlate the lateral stiffness 

suggested by the FEM model with that of the field section and laboratory value so that users can get 

a guidance of the required lab-based lateral stiffness that will provide enough performance in the 

field. 
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PROCEDURE TO DEVELOP ANSYS MODEL 

A six-slab fiber-reinforced concrete (FRC) FEM model is developed for analyzing the behavior of FRC slab 

with respect to different pavement structures, environmental conditions, loading, and joint stiffness. 

This model is developed entirely from scratch using ANSYS 2021 software. To develop this model 

effectively with ANSYS software, two main interfaces are used - ANSYS Workbench and Mechanical 

APDL (Ansys Parametric Design Language), as shown in Figure A - 1. ANSYS Workbench is more user-

friendly for developing the model, and Mechanical APDL facilitates an effective connection between the 

slabs and the base, which replicates aggregate interlocking and fiber connections. Workbench is used to 

build the model's elements, assign each element material, and apply forces to the model, such as 

temperature load and wheel loads, boundary conditions, and other design parameters. The results like 

stress and displacement are extracted from the Mechanical APDL interface. 

 

Figure A - 1: Interface of Workbench (left) and Mechanical APDL (Right). 

A.1 WORKBENCH 

In the workbench, modeling has been carried out step by step, beginning with the use of an appropriate 

analytical system to solve the model. Next come the material properties, geometry of the model, mesh, 

boundary condition, loadings, and lastly the solver and post-processing tool. The steps are taken to 

model this six-slab model are briefly described below.  

A.1.2 Units 

To select the units for the entire analysis,  

1. Go to the Units tab and select the preferred system.  
2. For this model “U.S. Customary (lbm, in, s, 0F, A, lbf, V)” is selected. 

A.1.3 Analysis system 

Several analysis systems, such as Steady State Thermal, Static Structural, Explicit Dynamic, etc., are 

available on the workbench. For this model, Steady State Thermal and Static Structure systems are used 

to develop the model, shown in Figure A - 2.  
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To insert the analysis system: - 

1. Drag the Steady-State thermal into the project schematic. 
2. Drag the Static structure analysis system onto the solution tab of Steady-State thermal. 

The flow that demonstrates how the data from the steady-state thermal solver is linked to the static 

structural solver will be generated automatically. The pink line displays the solution of one solver that is 

shared with another solver, while the blue line displays the exact data shared by both solvers. 

 

 

Figure A - 2: Analysis System. 

 

A.1.4 Engineering Data 

All the standard material properties are available under the engineering data tab. For this model, new 

materials are created because the FRC slab material properties are not predefined. As shown in Figure A 

- 3. the material properties depend on the type of FRC slab and the season of analysis. Table A - 1 and 

Table A - 2 (Barman et al, 2021) show the properties of the FRC slab and base used for the analysis. To 

change the properties in the workbench, follow the steps given below. 

1. Open Engineering data from Steady-State Thermal solver 
2. Select “FRC LAYER” from “Contents of Engineering Data” 
3. Change “Young’s Modulus” value under Isotropic Elasticity for the Cell of analysis, as given in 

Table A - 1. 
4. Select “Subgrade” under “Contents of Engineering Data” 
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5. Change the “Young’s Modulus” value under Isotropic Elasticity for the season of analysis, as 
given in Table A - 2. 

Note: - the value of all other properties like Isotropic thermal conductivity, Poisson’s ratio, bulk and 

shear modulus, and density will remain the same for all the analyses. Also, “Combined Modulus of 

subgrade reaction” value will be changed later, not in engineering data. 

 

a) Properties of FRC layer 

 

b) Properties of FRC layer 

Figure A - 3: Engineering Data. 

Table A - 1: Elastic modulus for FRC slabs. 

Cell FRC Layer Elastic 

modulus (psi) 
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506 5400000 

606 4300000 

706 4720000 

806 4610000 

 Table A - 2: Base layer and subgrade properties as per seasons. 

Seasons  Base layer Elstic 

modulus (psi)  

 Combined Modulus 

of subgrade reaction 

(psi) 

Early spring  9000 138.3 

Late spring  18000 276.6 

Summer  30000 461 

Fall 33000 507.1 

Winter  50000 768.3333 

A.1.5 Geometry (Space Claim) 

A geometry tab is used to open the space claim. Space claim allows user to draw the geometry of the 

model, as shown in Figure A - 4.The following steps are used for sketching the model. 

1. Set the coordinate system (x, y, z) as per desired orientation. 
2. For changing the units, go to Files > Space claim options > Units. (This change is only applicable 

in the space claim portion, not for the entire model) 
3. Sketch all the six 6ft x6ft slabs with the base using lines and rectangles in the x and y directions.  
4. Use the “Pull” command to change any measurements in the z-direction. (For different analyses, 

“Pull” command in the Sketch tab is used to change the thickness of the slab and base) 
5. Make sure to draw lines for the saw cut in slabs. 
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6. In this model, for ease of computation, the base is split into two parts using the “split body” 
command in the design tab. (The base split into the top 3 inches and the remaining thickness of 
the base). 

7. Using the “line” command in the sketch tab, two 6-inch by 8-inch rectangles are created on the 
center corner slab which replicates the wheel load area. 

8. Close the window after saving the sketch. 

 

Figure A - 4: Geometry (Space Claim). 

A.1.6 Model 

Open the Model tab from the steady-state thermal solver, a “Multiple System - Mechanical” window will 

open, shown in Figure A - 5. The geometry and material created in engineering data are automatically 

updated. In the Model window, on the left side the “Outline” window shows the steps for modeling (if 

not available, go to Home>Manage>outline). The following section explains further details to develop 

this model. 
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Figure A - 5: Model. 

A.1.6.1 Geometry 

In the Geometry tab, the sketch created in “space claim” is available as solid elements, Figure A - 6. 

 

Figure A - 6: Geometry in model. 

A.1.6.2 Material 

The materials which were created in “Engineering Data” are available in the material section. Each 

element is assigned to their respective material, as shown in Figure A - 7. 
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Figure A - 7: Materials. 

A.1.6.3 Coordinate System 

Coordinate system will remain the same as during the setup in space claim. 

A.1.6.4 Connection (Contact) 

The Connection tab helps to connect one element surface to another. Due to inconvenience in 

programming connections in the ANSYS workbench, this part is outsourced to APDL for ease of 

programming. Hence, all the contacts between slab and slab, and slabs and base are suppressed. This 

can be done by right-clicking "Connection”>Suppressed. Only the contact between the base layer 

remains bounded because it represents a single element, as shown in Figure A - 8. 

 

Figure A - 8: Connections. 
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A.1.6.5 Mesh 

Mesh is one of the important features of FEM analysis. In this model, 1-inch x 1-inch meshes are created 

for all slabs and top part of the base (3-inch). To reduce the computational time a 4-inch x 4-inch mesh 

created on the bottom layer of base as shown in Figure A - 9. The following are the steps for creating 

mesh. 

1. Select the required elements. 
2. Right click on Mesh>Insert>Sizing. 
3. Change element size as required. 
4. For non-symmetrical element (loaded slab),  

a. Right click on mesh > Insert Face Mesh at the bottom of the slab.  
b. Right click on mesh > Insert Method > select Hex Dominant method. 
c. Select loaded slab > Right click on mesh > Insert sizing > change element size. 

5. After assigning mesh to elements, right click on mesh and click on “Update or Generate Mesh”. 

 

Figure A - 9: Mesh. 

A.1.6.6 Named Selection 

The Named selections tab is used to name surfaces. In this model codes are run in APDL to create 

connections between slabs and interface surfaces. So, each specific surface is named distinctly for that 

purpose. The slabs are named from A to F as shown in Figure A - 10.  

For naming the surfaces: - 

1. Right click on the model > Insert > Named selection. 
2. Select the surface > right click on Named selection > insert > Named selection > name the 

surface. 
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In this model, ‘AB’ denotes the surface of Slab A that is oriented towards Slab B. ‘BA’ in turn denotes the 

surface of Slab B oriented towards Slab A. ‘BT’ denotes the top surface of the base. ‘ABT’ is the surface 

of Slab A oriented towards the base. 

 

Figure A - 10: Named Selection. 

A.1.6.7 Steady-State Thermal Solver 

Steady-State thermal analysis help to assessing the equilibrium state of the model subjected to specific 

temperature and environmental loading. From the thermocouple sensors installed in MnRoad cells, 

temperature reading has been taken over the course of time (Barman et al., 2021). From the data 

available, extreme temperature at top of the slab and bottom of the slab for each season are included in 

the analysis as shown in Table A - 3. Following are the steps to apply thermal load in the model. 

1. Add initial temperature for the analysis. 
2. Select all top surfaces of the FRC slab. 
3. Right-click on Steady-State Thermal > Insert > Temperature. 
4. Type the top surface temperature magnitude of FRC slab from Table A - 3. 
5. Select all bottom surfaces of the FRC slab. (Hide the base slab to select bottom surface of the 

slab) 
6. Right-click on Steady-State Thermal > Insert > Temperature. 
7. Type bottom surface temperature magnitude of FRC slab from Table A - 3. 

1 0, 0,  

1 0, 7 ,  

1 0, 1  ,  

1 0,  16,  

19 , 0,  

19 , 7 ,  

19 , 1  ,  

19 ,  16,  

 6 , 0,  

 6 , 7 ,  

 6 , 1  ,  

 6 ,  16,  

1 6, 108,  

Y

  

A

B

C

F

E

D
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8. After applying both temperatures at the top and bottom, right-click on Steady-state thermal > 
Solve. 

Note:- do not solve from the home button this will solve the whole analysis. Make sure that after 

solving, there is a green tick beside the solution of Steady-State thermal solver, as shown in Figure A 

- 11. 

Table A - 3: Day and night temperature data for all seasons. 

  
Temp Grad in 

F/in 
  6" slab 5 " Slab 4" slab 

  
Night-

time 

Day-

time 
Surface 

Night-

time 

Day-

time 

Night-

time 

Day-

time 

Night-

time 

Day-

time 

Summer -2.93 4.71 

Top 87.30 118.24 87.30 118.24 87.30 118.24 

Bottom 104.85 89.98 101.93 94.69 99.00 99.40 

Fall -2.19 3.11 

Top 14.59 68.38 14.59 68.38 14.59 68.38 

Bottom 27.76 49.72 25.57 52.83 23.37 55.94 

Winter -2.56 4.48 

Top -12.73 64.29 -12.73 64.29 -12.73 64.29 

Bottom 2.63 37.41 0.07 41.89 -2.49 46.37 

Early 

Spring 
-2.15 5.35 

Top 19.15 82.11 19.15 82.11 19.15 82.11 

Bottom 32.04 50.02 29.89 55.37 27.74 60.72 

Spring -2.43 5.35 

Top 78.96 88.93 78.96 88.93 78.96 88.93 

Bottom 93.50 56.84 91.08 62.19 88.65 67.54 
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Figure A - 11: Steady- State Thermal. 

 

A.1.6.8 Static Structure Solver 

Static structure simulation helps to evaluate impact of static loading on a model. This simulation can 

evaluate stress, strain, and deformation for various loading condition. In this model, all possible loading 

and boundary conditions are applied such as wheel load, friction load, elastic support, and boundary 

condition for slab and base, shown in Figure A - 12. The solution of A.1.6.7 Steady-State Thermal Solver 

is also added in this solver as they are linked. 

 

Figure A - 12: Static Structural. 

Following are the steps for adding all loading and boundary conditions to this model. 
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1. Select the outer surfaces of both the base layers as shown in Figure A - 13. 
2. Right click on Static-structural > Insert > Displacement 
3. In details of “Displacement” keep   and Y component as “0” and   component as “Free”. 

 

 

Figure A - 13: Boundary Conditions – Base. 

4. Select bottom surface of underneath base layers as shown in Figure A - 14. 
5. Right click on Static-structural > Insert > Elastic Support. 
6. As per season of analysis, in details of “Elastic Support” change foundation stiffness to the 

values provided in Table A - 2. 

 

Figure A - 14: Boundary Conditions – Subgrade. 

7. Select all outer surface of both FRC slabs as shown in Figure A - 15. 
8. Right click on Static structural > Insert > Remote Displacement. 
9. In details of “Remote Displacement” keep   and Y component as “0” and   component as 

“Free”. Also, keep rotation of  , Y, and   as “Free”.  
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Figure A - 15: Boundary Conditions – FRC Slab. 

10. For applying dual wheel load in this model, select both the rectangular surface on middle-corner 
FRC slabs (B-Slab) as shown in Figure A - 16. 

11. Right click on Static-structural > Insert > Pressure. 
12. In “Pressure” tab the magnitude is kept as 93.7  psi on both the surfaces. Make sure that 

direction of loading is in downward direction. 
Note: - A standard dual assembly load, 9000 lbs, is considered for the analysis. In this model 

wheel load applied as pressure on two 6 by 8-inch surface. So, 93.75 psi is applied as pressure. 

 

Figure A - 16: Wheel Load. 

13. Again, select both the rectangular surfaces on middle-corner FRC slabs (B-Slab) as shown in 
Figure A - 17 for applying frictional loading. 

14. Right click on Static structural > Insert > Pressure. 
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15. A pressure of magnitude 14.063 psi is applied on both the surfaces. Make sure that direction of 
loading is in opposite direction of traffic movement. 
Note: - this 14.063 psi pressure is 0.15 of 93.75 psi which is the frictional loading due to wheel 

load. 

 

Figure A - 17: Frictional load due to wheel. 

16. After applying all the loading and boundary conditions make sure all the elements have a green 
tick beside it. 

17. For importing the solution of Steady-State Thermal solver to Static-structural solver. Right click 
on “Imported Load” > Import Load. 

18. Imported body temperature should look like the one in Figure A - 18. 

 

Figure A - 18: Imported Load from Steady State Thermal solver. 

 



 

93 

 

A.1.7 Export Model of Workbench to Mechanical APDL 

To export the model from Workbench to Mechanical APDL follow the given steps. 

1. Select “Static Structural” from outline toolbox. 
2. Go to Environment tab > Write Input File > Select destination to save the file. 
3. A “.dat” file will be saved on selected destination which will be imported in Mechanical APDL. 

An example of the nomenclature of .dat file is 606ESD4S4 which means Cell (606) -Season (Early Spring) 

-Day/Night (D) -thickness of slab (4-inch) - saw cut- thickness of base (4-inch) 

A.2 MECHANICAL APDL 

For the current FEM model, all of the designing and modeling except the connections between slab to 

slab and interface of slabs and base are modeled in ANSYS workbench. For modeling connections 

Mechanical APDL interference is used. The remaining procedure, including programming the 

connections and extracting solutions from the model is covered in the upcoming sections. 

A.2.1 Importing the Model  

For importing model from the “.dat” file follow the steps. 

1. Open “Ansys Mechanical APDL Product Launcher” as shown in Figure A - 19. 
2. Select a folder to run the APDL model. (Not necessary to select same folder as the .dat file) 
3. Click “Run”. 
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Figure A - 19: Ansys Mechanical APDL Product Launcher. 

4. A new APDL window labelled “Ansys Mechanical Enterprise Utility Menu” will open. 
5. To import the .dat file, Go to File menu > Read Input File > Select .dat file. 
6. To visualize the model, Go to Plot menu > Replot. A typical model will look like Figure A - 20. 
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Figure A - 20: Ansys Mechanical APDL – Model. 

A.2.2 MATRIX27 

To create connections between slab to slab and Slabs to base an inbuilt element MATRIX27 is used. To 

apply it follow the steps. 

1. In the Main Menu under Preferences, go to Preprocessor > Element Type > Add > Select “User 
Matrix” > Select “Stiff Matrix  7”, as shown in Figure A - 21. 
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Figure A - 21: MATRIX27 Element. 

2. Go to “Real constants” > Add/Edit/Delete > click on “Add” > Select the new element 
“MATRI  7” and click “OK”, as shown in Figure A - 22. 

 

Figure A - 22: Real Constant. 

3. A new window will pop up, as shown in Figure A - 24, make sure the element type references 
number and real constant set number should be same. 

4. Add coefficients of stiffness for MATRIX27, as shown in Figure A - 24.  
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Note: -The stiffness constant C1, C13, C24 and C58, C64, C69 are positive coordinates of x, y, z 

direction stiffness matrix respectively. C7, C19, C30 are negative coordinates of x, y, z direction 

stiffness matrix respectively, shown Figure A - 23. 

 

Figure A - 23: 12x12 Stiffness Matrix. 
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Figure A - 24: MATRIX27 Constants. 
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5. After adding stiffness values for slab to slab connection, Go to Modeling > Create > Element > 
Element Attributes, As shown in Figure A - 25. 

6. Select Element type number of MATRIX27 for slab to slab and Real constant set number. Make 
sure both the numbers are same, as shown in Figure A - 25. 

 

Figure A - 25: Element Attributes. 

7. After defining attributes, MATRIX27 needs to be linked from node to node for connection 
between slabs. A code has also been written, as shown in Table A - 4 which should achieve this. 
Copy the code and paste in “Command Prompt” and click on Enter.  

Table A - 4 : Slab to slab connection code 

cmsel,s,AB 

nd1=ndnext(0) 

*dowhile,nd1 

 ! do something 

 x = nx(nd1) 

 y = ny(nd1) 

 z = nz(nd1) 

 cmsel,s,BA 

 nsel,r,loc,x,x-.001,x+.001  
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 nsel,r,loc,y,y-.001,y+.001 

 nsel,r,loc,z,z-.001,z+.001 

 nd2 = ndnext(0)  

 e,nd1,nd2 

 ! if necessary, move one of the nodes to make element non-zero length 

 ! move 

 cmsel,s,AB 

 nd1=ndnext(nd1) 

*enddo 

cmsel,s,AF 

nd1=ndnext(0) 

*dowhile,nd1 

 ! do something 

 x = nx(nd1) 

 y = ny(nd1) 

 z = nz(nd1) 

 cmsel,s,FA 

 nsel,r,loc,x,x-.001,x+.001  

 nsel,r,loc,y,y-.001,y+.001 

 nsel,r,loc,z,z-.001,z+.001 

 nd2 = ndnext(0)  

 e,nd1,nd2 

 ! if necessary, move one of the nodes to make element non-zero length 

 ! move 

 cmsel,s,AF 

 nd1=ndnext(nd1) 

*enddo 

cmsel,s,BE 

nd1=ndnext(0) 
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*dowhile,nd1 

 ! do something 

 x = nx(nd1) 

 y = ny(nd1) 

 z = nz(nd1) 

 cmsel,s,EB 

 nsel,r,loc,x,x-.001,x+.001  

 nsel,r,loc,y,y-.001,y+.001 

 nsel,r,loc,z,z-.001,z+.001 

 nd2 = ndnext(0)  

 e,nd1,nd2 

 ! if necessary, move one of the nodes to make element non-zero length 

 ! move 

 cmsel,s,BE 

 nd1=ndnext(nd1) 

*enddo 

cmsel,s,BC 

nd1=ndnext(0) 

*dowhile,nd1 

 ! do something 

 x = nx(nd1) 

 y = ny(nd1) 

 z = nz(nd1) 

 cmsel,s,CB 

 nsel,r,loc,x,x-.001,x+.001  

 nsel,r,loc,y,y-.001,y+.001 

 nsel,r,loc,z,z-.001,z+.001 

 nd2 = ndnext(0)  

 e,nd1,nd2 



 

102 

 

 ! if necessary, move one of the nodes to make element non-zero length 

 ! move 

 cmsel,s,BC 

 nd1=ndnext(nd1) 

*enddo 

cmsel,s,DE 

nd1=ndnext(0) 

*dowhile,nd1 

 ! do something 

 x = nx(nd1) 

 y = ny(nd1) 

 z = nz(nd1) 

 cmsel,s,ED 

 nsel,r,loc,x,x-.001,x+.001  

 nsel,r,loc,y,y-.001,y+.001 

 nsel,r,loc,z,z-.001,z+.001 

 nd2 = ndnext(0)  

 e,nd1,nd2 

 ! if necessary, move one of the nodes to make element non-zero length 

 ! move 

 cmsel,s,DE 

 nd1=ndnext(nd1) 

*enddo 

cmsel,s,CD 

nd1=ndnext(0) 

*dowhile,nd1 

 ! do something 

 x = nx(nd1) 

 y = ny(nd1) 
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 z = nz(nd1) 

 cmsel,s,DC 

 nsel,r,loc,x,x-.001,x+.001  

 nsel,r,loc,y,y-.001,y+.001 

 nsel,r,loc,z,z-.001,z+.001 

 nd2 = ndnext(0)  

 e,nd1,nd2 

 ! if necessary, move one of the nodes to make element non-zero length 

 ! move 

 cmsel,s,CD 

 nd1=ndnext(nd1) 

*enddo 

cmsel,s,FE 

nd1=ndnext(0) 

*dowhile,nd1 

 ! do something 

 x = nx(nd1) 

 y = ny(nd1) 

 z = nz(nd1) 

 cmsel,s,EF 

 nsel,r,loc,x,x-.001,x+.001  

 nsel,r,loc,y,y-.001,y+.001 

 nsel,r,loc,z,z-.001,z+.001 

 nd2 = ndnext(0)  

 e,nd1,nd2 

 ! if necessary, move one of the nodes to make element non-zero length 

 ! move 

 cmsel,s,FE 

 nd1=ndnext(nd1) 



 

104 

 

*enddo 

8. After the connection for slab-to-slab, slabs to base (interference) connection are also modeled. 
Follow the previous steps from 1 to 6, with new MATRIX27 element. 

9. After step 6, copy and paste the code for interference connection, shown in Table A - 5. 

Table A - 5 : Slabs to base (interference) connection code 

cmsel,s,CBT 

nd1=ndnext(0) 

*dowhile,nd1 

! do something 

 x = nx(nd1) 

 y = ny(nd1) 

 z = nz(nd1) 

 cmsel,s,BT 

 nsel,r,loc,x,x-.001,x+.001  

 nsel,r,loc,y,y-.001,y+.001 

 nsel,r,loc,z,z-.001,z+.001 

 nd2 = ndnext(0)  

 e,nd1,nd2 

 ! if necessary, move one of the nodes to make element non-zero length 

 ! move 

 cmsel,s,CBT 

 nd1=ndnext(nd1) 

*enddo 

cmsel,s,ABT 

nd1=ndnext(0) 

*dowhile,nd1 

 ! do something 

 x = nx(nd1) 

 y = ny(nd1) 
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 z = nz(nd1) 

 cmsel,s,BT 

 nsel,r,loc,x,x-.001,x+.001  

 nsel,r,loc,y,y-.001,y+.001 

 nsel,r,loc,z,z-.001,z+.001 

 nd2 = ndnext(0)  

 e,nd1,nd2 

 ! if necessary, move one of the nodes to make element non-zero length 

 ! move 

 cmsel,s,ABT 

 nd1=ndnext(nd1) 

*enddo 

cmsel,s,BBT 

nd1=ndnext(0) 

*dowhile,nd1 

 ! do something 

 x = nx(nd1) 

 y = ny(nd1) 

 z = nz(nd1) 

 cmsel,s,BT 

 nsel,r,loc,x,x-.001,x+.001  

 nsel,r,loc,y,y-.001,y+.001 

 nsel,r,loc,z,z-.001,z+.001 

 nd2 = ndnext(0)  

 e,nd1,nd2 

 ! if necessary, move one of the nodes to make element non-zero length 

 ! move 

 cmsel,s,BBT 

 nd1=ndnext(nd1) 
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*enddo 

cmsel,s,DBT 

nd1=ndnext(0) 

*dowhile,nd1 

 ! do something 

 x = nx(nd1) 

 y = ny(nd1) 

 z = nz(nd1) 

 cmsel,s,BT 

 nsel,r,loc,x,x-.001,x+.001  

 nsel,r,loc,y,y-.001,y+.001 

 nsel,r,loc,z,z-.001,z+.001 

 nd2 = ndnext(0)  

 e,nd1,nd2 

 ! if necessary, move one of the nodes to make element non-zero length 

 ! move 

 cmsel,s,DBT 

 nd1=ndnext(nd1) 

*enddo 

cmsel,s,EBT 

nd1=ndnext(0) 

*dowhile,nd1 

 ! do something 

 x = nx(nd1) 

 y = ny(nd1) 

 z = nz(nd1) 

 cmsel,s,BT 

 nsel,r,loc,x,x-.001,x+.001  

 nsel,r,loc,y,y-.001,y+.001 
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 nsel,r,loc,z,z-.001,z+.001 

 nd2 = ndnext(0)  

 e,nd1,nd2 

 ! if necessary, move one of the nodes to make element non-zero length 

! move 

 cmsel,s,EBT 

 nd1=ndnext(nd1) 

*enddo 

cmsel,s,FBT 

nd1=ndnext(0) 

*dowhile,nd1 

 ! do something 

 x = nx(nd1) 

 y = ny(nd1) 

 z = nz(nd1) 

 cmsel,s,BT 

 nsel,r,loc,x,x-.001,x+.001  

 nsel,r,loc,y,y-.001,y+.001 

 nsel,r,loc,z,z-.001,z+.001 

 nd2 = ndnext(0)  

 e,nd1,nd2 

 ! if necessary, move one of the nodes to make element non-zero length 

 ! move 

 cmsel,s,FBT 

 nd1=ndnext(nd1) 

*enddo 

Note: - the interference code may take 5 to 10 min (depending on the processor) to run. 



 

108 

 

A.2.3 Final Run 

After modeling all elements, the final run will be completed by the following steps. 

1. Write a command in the command prompter- “allsel.all” and click Enter. 
2. Go to Solution > Solve > Current LS, as shown in Figure A - 26. 
3. Click OK if any warning message pops up. 

 

Figure A - 26: Final Run 

A.3 RESULT EXTRACTION 

After successfully running the model, the below-mentioned steps are followed for result extraction in 

Mechanical APDL. 

1. Go to General Postproc > Read Result > First Set, as shown in Figure A - 27. 
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Figure A - 27: Read result 

2. For visualizing the stress, strain, or deformation of the model, go to Plot Result > Contour Plot > 
Nodal Solution. 

3. A window will pop up with different options such as DOF solution, Stress, Strain as shown in 
Figure A - 28. 

 

Figure A - 28: Plot Result 
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4. For exact values of nodal stress, strain, or deformation of the model go to List Result > Nodal 
Solution. 

5. A window will pop up with different options such as DOF solution, Stress, Strain to get exact 
nodal value from analysis, as shown in Figure A - 29. 

6. A sample of the displacement result is shown in Figure A - 30. 

 

Figure A - 29: List Result 

 

Figure A - 30: Sample list result 

7. To select exact node or get exact nodal solution go to Select menu > Entities > Select the node. 
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A.4 FINAL RESULT 

In this model, stress and displacement values are extracted from critical nodes. Different parameters are 

evaluated such as load transfer efficiency, max displacement, differential displacement etc. for different 

pavement structures and seasons. All possible graphs are available in the excel sheets. 

 

 

 


